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Introduction

NETool is building a numerical model based on the reservoir, completion, fluid and
simulation setup information. This information is imported or defined by the user in the
graphical user interface. The user is therefore shielded from the logic and algorithms
described below, this is taken care of automatically by NETool.

When building the numerical model the individual components in a well completion are
mapped onto a discretized network system consisting of nodes with flow connections
linking the nodes.

Two examples of network system are shown in Figure 1 and Figure 2.

. Reservoir inflow

. Casing/Liner

_ Sand Control

Annuli ¢

. Inflow Control

Stinger

Tubing

Figure 1. NETool General Node Configuration

L e g

Figure 2. Node Configuration for ICYV Completion

The general node configuration is presented in Figure 1. The uppermost row of nodes in
this figure shows the layer of reservoir nodes (also called external nodes). The next four
rows of nodes represent annuli within the well, and the lowermost row represents the
inner production tubing. The number of annular layers dependinds on the completion
type.

As mentioned above the user is shielded from the details of the numerical network shown
and described above. Via the NETool user interface, the user specifies reservoir
properties, completion type and configuration along the well. All parameters can be
varied, mixed and combined along the well making it possible to model complex
completion.

NETool defines the numerical network and the pressure drop correlations to be used for
each individual flow connection. This is based on the specifications supplied by the user.
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Flow between the reservoir layer and the annulus layer (top row and the next one) is
specified by advanced PI correlations involving 3D permeability averaging and phase
exchange effects towards the wellbore.

By configuring the completion type, the fluid flow performance between the annuli and
tubing layers, within the annuli layers, and within the tubing layer can be modeled.

Figure 2 shows a node system used for Inflow Control Valve completions, which
typically consists of ICVs, packers and blank pipes. This nodal network is the results of a
completion where flow from a long area of the formation is controlled by a single entry
point into the tubing and where the annular flow is separated from other entry points by
packers.
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Basic Assumptions

NETool simulations are based on the following assumptions:

o Three phase black oil based PVT formulation of the hydrocarbon fluid
system with oil, gas and water. NETool can run in three-phase, two-phase
or single phase modes. It allows for vaporized oil, condensates, wet gas,
multiple bubblepoints and multiple dewpoints.

o Isothermal, steady-state flow conditions for sub-sonic flow conditions.

o The flow within the well is locally one-dimensional, i.e. the annulus or
tubing flow between two adjacent nodes along the well is averaged over
the cross section within the annulus or tubing.

o The general pressure drop calculations within the annulus and the tubing
are general momentum balance equations for pipe flow (Bernoully)
including friction, compressibility and hydrostatic phenomena.

o Linear Darcy flow equation is used if annulus is filled with gravel or
collapsed rock.

o The reservoir flow performance is based on Productivity Index models and
phase fractions. Local Pls are defined according to the average reservoir
properties. Permeabilities can be locally averaged along the well
trajectory. The averaging process considers heterogeneities and
anisotropies.

o The pressure drop calculations through completions components are based
on a variety of different configurable correlations or equations depending
on the actual component.

o Flow in and out of junctions is treated by simple relationships, thus
avoiding multi dimensional computations.

o The network geometry of nodes and flow channels is sufficiently general
to allow simulation of most completion types, however, simple enough to
satisfy the requirement of computational efficiency and numerical
stability.

. There are also capabilities to simulate using single-phase, power-law type
fluids, i.e. drilling muds.

Overview of Software User Interface

NETool must be populated with well information, reservoir and completion data to
perform simulations. It can be populated with data from logs, spreadsheets and reservoir
simulation models, or by simple manual data entry.

There are also correlations available to generate PVT and Relative Permeability data
within NETool itself.

An overview of data requirements for running NETool is illustrated in Figure 3.
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The capability to import a reservoir simulation model loads grid block dimensions,
permeability, saturations, pressures and other reservoir and fluid properties. This is a very
efficient way to supply NETool with the basic data. Currently NETool can import
reservoir simulation model files in formats supported by the standard black-oil Eclipse
E100 reservoir simulator as well as some Eclipse E300 grids.

The main menus and views in graphical user interface are shown in Figure 4.
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Figure 4. Main Menu and Views

Top Menu

The top menu bar contains:

File — Various capabilities to organize projects and wellcases (load, save, etc)
Edit — Preferences, detailed editing of well trajectory and laterals

View — Wellbore (mainbore or lateral)

Units — Selecting the basic Unit set: SI, Metric or Field.

Help — User Manual and Technical Manual. Enter license key. Display version
information.
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Reservoir and Well View

e This view is displayed when the Reservoir & Well tab is selected in the bottom left
corner. An example is given in Figure 5. The view visualizes well and reservoir data,
and facilitate entry of well paths and well segmentation:

Well paths can be defined by three alternative methods: 1) import of deviation survey
data, i1) import of UTM coordinates or iii) interactively by clicking and dragging with the
mouse in the graphical views or by entering values in the table on the left hand side. The
well path is represented by a collection of Trajectory Points.

Well segmentation subdivides wells into segments. The segment boundaries are defined
by Nodes within NETool. A segment contains equal reservoir and completion properties
within the entire segment. The properties can be different from segment to segment.

The uppermost graphical panel on the screen shows a lateral, birds-eye view of the
reservoir and the well path. If a reservoir grid is present the view will show reservoir
simulation grid layers and their respective reservoir properties.

The middle graphical panel illustrates a cross section of the reservoir along the defined
well trajectory. If a reservoir grid is present the view shows detailed property
distributions for the cross section along the well.

The lowermost graphical panel shows completion schematic for the selected lateral.

u

=4 a4 bk

SN BN
MY B N RN

Figure 5. Example of Well View w/Reservoir Grid

Fluid Properties View

The Fluid Properties panel is used to define:
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PVT data — Oil, Water, Gas. Different formats and PVT correlations available.
Relative Permeability data — Oil, Water, Gas. Different formats and RelPerm

correlations available.

Lift Performance data — In Eclipse VFP table format. Gas lift is also allowed.
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Figure 6. Example of Fluid Properties View
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Global Settings View

The Global Settings panel is used to define:

General configurations — Well type, simulations targets, pipe flow correlations
Inflow — PI model specifications

Advanced - convergence configurations

Output — Specify results parameters to be reported and an option for enter PLT data
Annotation — Provide detailed description of well case

= — [
’.@J'ﬁlohﬁ '- 4= _X
File Edit Units
_[ G&ae;aﬂ Inflow T Advanced T Qutput T Annotation ]
=]
Well type [Frodu cer | TJ
Phase Mode
0il ]
Gas ]
Water ]
Boundary Condition
Target [Tubing Head Pressure 'J
Tubing Head Pressure 70.0 Bar
Minimum BH Pressure 200.0 Bar
Gas Lift Rate 0o MMSm>day
Hydrostatic
r .|
Use Hydrostatic [+
Reservoir Pressure
f ]
Feservoir Pressure from [Deﬁned Along the Well for Each Segment .'I'J
FPressure Drop in Tubing
i ™
Pressure Drop Method [Eleggs&ElriII ‘F]
PLET
r B |
Owverlay Output with PLT Data |:|

| OK || cancel |

Figure 7. Example of Global Settings Window
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Segment Settings/Completion View

This panel is used to define 1) reservoir, i1) completion and iii) well parameters along the
wellbore.

These parameters can be fully varied to honor reservoir heterogeneities along the well
and to build complex completions.

Examples of some parameters:

Borehole size

Completion parts and their configurations

Reservoir properties (manually entered, imported from logs or taken from grids)
Skin information

Permeability in collapsed annulus
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Figure 8. Example Segment Settings/Completion View

External Plots View

This panel allows for entering data that can be plotted together with NETool results. One
example is to enter rate information from PLT logs that can be used for history-matching
the NETool model. PLT data can also be entered in Global settings=>Output.
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Figure 9. Example of External Plots View

Results Viewer

Once all required data for a simulation is populated, the user submits the job and the
results are displayed directly on the screen as plots and tables.

The Results Viewer shows calculated flow rates, pressure drops, phase fractions, fluid
velocities, densities, viscosities, fluid fluxes, permeabilities and other parameters.

The Results Viewer has capabilities for making customized plots; Legend text can be
edited, compare plots combining results from different simulations can be made and it is
possible to plot external data together with simulated data.

Detailed graphs of PVT and Relative Permeability data are also displayed.

The Results Viewer facilitates copy-paste functionality of the plots and tables into
applications like Word and Powerpoint.

It is also possible to save results in the Plots Viewer in a separate file for later use or for
exchanging results with other NETool users.

5000.0.1.0 Page 16 of 113 2012



NEToo0l™ User Guide

Landmark

iy

L -

EEE N E N N R R e ]
imr [T,

—

arkin - A

& T = = ] g =

175 | = E

i L — — o - ke

RTEAl iz - L d

# = | __._,.."‘f "_._,_.-""_'— o~

P et e

i
B Ta M s We LG Tl e B wh) (4B CEW 180 1S 1MW 1A 17N 1N 18 W D08 ENR D0 B SO0 S 1T DA D W R
[ —
R
o
[
[t
[
kvl ey
ST WM T W 1N W G OB 080 M (oW I (308 VIR0 (408 (W (K 1TE (6 (W TH0 1100 CIW TH WM T T8 ITE) TR Ne0 8 11 1K 0 W
- |

]
e
il

B i | ey b e

s sl 5w e
Figure 10. Example of Results Viewer

Work Processes

Work processes are as usual important for efficient usage of a software application.
NETool has the Wizard capability that guides new users through the initial steps when
populating NETool with data.

Figure 11 is an illustration of structured NETool work processes that may be helpful.
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NETool Work Process

Comparison Input Panels

Reservoir D ata from Edipse Reservoir Data from report or logs

bl  Reservoir Parameters¥ and by well Path )
Fluid Properties2! from Edipse Huer;mr:ﬂell
Irnp ot ) well Searments un
e} Well Path d)  Fluid Praperties? Flud Properties
Penel
i) :
d} Well Segrments = el Define Reservoir Parameterst
- - o ranually or irmport frorm logs Segment
=3 Cormpletion Configurations 5 SeHings !
) = i Cornpletion Configurations Cormpletion
1] FI rodel {reservair flow rmodel) Panel
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gl Simulation Targets and Control Globml Settings
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i Anal yse Results
1 Analyse Results
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Figure 11. Example of NETool Work Process

The Mathematical Model

Mathematically, NETool is based on conservation of mass and momentum of oil, gas and
water components.

The general momentum balance equations are replaced by correlations expressing
pressure drop as functions of total volumetric flow rate, phase fractions, flow geometry
and fluid properties.

Permeability, Productivity Index & SKkin

There are different correlations associated with different parts of the numerical network.

Starting at the upstream end, inside the reservoir, the reservoir pressure drop correlation
is based on Darcy’s law for flow in permeable media. Permeabilities, PI models and
Skins are used to define the pressure drop in the reservoir.
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Permeability

A reservoir simulation model contains scattered permeability data, and NETool is able to
honor those permeability variations in the reservoir by applying upscaling. This upscaling
process is performed in NETool under the assumption of pure radial flow.

The permeability values are essential in PI models unless transmissibilities are supplied
directly.

PI Model

The user can choose between PI models for i) steady state or ii) semi-steady state flow
conditions.

Vertical wells use standard radial Darcy flow equations.

Horizontal wells use Joshi for steady state flow, and Babu and Odeh for semi-steady state
flow.

Deviated wells use a transformation of both the vertical and horizontal formulations.

The PI models are used to represent the reservoir performance, by utilizing local Pls
according to the permeability variations along the well trajectory.

There is an option to define the total PI for the well. If enabled, the local Pls are
calculated and scaled proportionally to the local reservoir properties to fit the total well
PIL.

Please be aware it is important to supply a consistent set of reservoir pressures and
reservoir boundaries in order to get the PI modeling right.

Skin

Local skin values may also be included in the PI model. Currently, the following skin
models are provided:

Damage zone skin

Non-Darcy skin based on Forchheimer coefficient

Additional skin

Flow convergence skin (i.e. skin caused by flow convergence around perforations)

Perforation skin as functions of perforation depth, phasing angle, crushed zone radius,
perforation density and gun data

Two different perforations skin models are offered: 1) Karakas and Tariq and 1i) Furui,
Zhu and Hill. The Karakas and Tariq perforation skin model was originally created for
vertical wells. In order to make them applicable to horizontal wells, a transform is applied
to make an anisotropic medium appear as isotropic.

Pressure & Saturation

Reservoir pressures are required for each segment and must always be supplied.

Saturations are also normally supplied. Saturations are used to define relative
permeability values by look-up in Relative Permeability curves and correlations.
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The fractional flow feature can be used instead of a set of saturations and relative
permeability curves. This feature is a simplified and easy way to define phase fractions
and can be used for quick-look purposes.

If a reservoir simulation model has been imported with saturation and pressure data, then
saturations and pressures can be retrieved from the grid block(s) the well is passing
through. Or alternatively these values may be entered manually or populated from a log.

Completion types

The pressure drop correlations to be employed for the different parts of the completion
are interactively selected in the menu system. All the completion types can be fully
mixed and varied along the well.

Separate correlations are provided for the following completion types:
Inflow Control Valve (ICV) Device

Slotted liner

Open hole

Perforated cemented liner

ICD — Nozzle ICD

ICD — Tubular ICD

ICD — Channel ICD

Halliburton EquiFlow ICD

Halliburton EquiFlow adjustable ICD

Baker spiral ICD, Troll field

Baker spiral ICD, General

Baker adjustable ICD

Autonomous ICD

Screens

Gravel Pack (as Screen + Gravel in Annulus)
Cased Hole Gravel Pack (as Screen + Gravel in Annulus + PCL)
Blank pipe

Cemented blank pipe

Packer

Tubing Plug/Choke

Completion lavyers

Well in Netool can have up to four different completion layers:

Casing/Liner
Sand Control
Inflow Control
Stinger
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Each of these layers has certain completion types available depending on the layer’s
designation. Stinger is the most inner layer, while Casing/liner is the most outer one.

If a segment has more than one layer their diameters should be in the increasing order
from Stinger to Casing/Liner. Layers can touch each other making zero annulus clearance
but they can’t overlap.

However, layers of neighboring segments can overlap. F.ex. Stinger at segment #1 can
have larger ID and OD than Sand Control at segment #2.

Completions
Tubing plug/choke N R SR - .
0.0
10 oA = :ﬂ
150 -
200 ®
250 a -
Gravel == -
350
400
45
e oo
Packers 6
\| ] =
. . 700
Casing/liner
Boo
B50
Sand Control —_ *~
1000 =
1050
1100
Inflow control —.
1200
1250
Stinger ——«
1350
Wellbore —
Reservoir = ...

Figure 12. Four annulus layers supported by Netool.
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Boundary Conditions

A NETool simulation requires the following boundary conditions:

Outer boundaries:

Reservoir pressure at each reservoir node

Inner boundary - one of the following simulation targets:
Flowing bottom hole pressure

Tubing head pressure

Total volumetric reservoir rate (at reservoir conditions)
Total liquid rate (at standard conditions)

Oil rate (at standard conditions)

Gas rate (at standard conditions)

Water rate (at standard conditions)
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Download and Installation

Program Download

NETool is available for download from the Landmark Software Manager (LSM), our
Electronic Software Delivery (ESD) tool (http://esd.halliburton.com). Download of
releases from the LSM Releases tab is restricted to individuals who are authorized to
receive the software. Not all users can download from this area. Additional information
about the LSM is located at:

http://css.lgc.com/CustomerSupport/RS000LSMStart.jsp

The LSM offers several advantages:

Notification of new releases or patches that have become available.

Immediate access to new releases or patches.

Ability to review and download Release Notes and Installation Guides prior to download.
History of software products and versions that have been downloaded.

A single location for a holistic view of your Landmark application environment.

Ability to request DVDs where bandwidth issues prevent download.

If you have been given access to receive and deploy NETool, you will need to register
your account in the Customer Support Portal, in order to access the LSM. The top of this
email contains your PIN and the email address needed to register your account.

Go to the Customer Support Portal at:
http://css.lgc.com/CustomerSupport/CustomerSupportHome.jsp
Under the Please Sign In area, click the Register your PIN here link.
Enter your PIN and email address as provided above.

Follow the remaining instructions to create your password.

Click Download for your desired LSM platform.

License control

NETool 5000.0.1.0 requires license codes to be issued by Landmark Graphics
Corporation. Licenses issued for version 5000 will work. However, all licenses for 3.x
and earlier versions will not.

Compatibility with Earlier Versions

All files created with NETool 3.0 and later versions can be opened in NETool 5000.
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The opposite—opening files created with NETool 5000 with earlier versions of NETool
— may or may not work depending on the file.

NETool 5000 and NETool 3.xx install in different folders, use different license files, and

can be run independently of each other. However the two versions share the files
database, please understand the files compatibility if using both versions in parallel.
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Getting Started With NETool

Wizard - Define Well Case

Proper work processes are important to utilize NETool’s capabilities efficiently.

The easiest way for a beginner is to create the first well case by using the Wizard
capabilities. The wizard starts from File>Open From Wizard.

It guides users stepwise through data import and definition processes up to the point
where detailed completion and reservoir details need to be supplied.

After using the wizard several times the user usually gets acquainted with the NETool
work process and menus, and will prefer to create and modify well cases without a
wizard.

[ Wizard for Beginners / Define Well Case. -

This Wizard will carrv vou through the steps required to make a
NETool well case. The following steps are covered:

Import a new or open existing reservoir model

. Define well path within the reservoir

. Specify well segments by adding nodes to the well path
Define well tvpe, active phases, simulation fargef, efc
Define PT

Specify PVT

. Specify Relative Permeability

. Specify Tubing Lift Performance

ool ko R L b

To exit wizard at any stage. press the "Cancel" button.

Next> || Cancel

Figure 13. Input Wizard First Screen
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Manage Reservoirs, Projects and Well Cases

e This section describes the organization of NETool data. The data is stored in a file
repository which constitutes the NETool’s database.

e NETool simulations are grouped into Projects. One project is typically for the same
reservoir and the top grouping level is therefore named Reservoir/Project.

e NETool simulations are called Well cases. A Reservoir/Project group usually
contains many wellcases.

e The operations to organize NETool data are gathered in the File and Edit dropdown
menus which are found on the top menu bar.

Data File Repository

NETool maintains a file repository where data is saved and loaded. The user should not
manually operate the repository outside NETool User Interface.

Repository Location

The default location for the repository depends on the operating system:

Windows XP®, C:\Documents and Settings\<<username>>\Application
Windows 2003® Data\NETool\

Windows Vista®, | C:\Users\<<username>>\AppData\Roaming\NETool\
Windows 2008®,

Windows 7®

Linux® /home/<<username>>/.netool/

The default location can be altered by user configuration as described in the following
sections. When NETool starts, the information about the repository location is printed out
into NETool console window.

Change Repository Location

In some cases, it is more convenient to define the NETool repository at another location
than the default. The repository location can be configured interactively or defined in a
configuration file as described in the next sections.

A network drive can for example be convenient when:

e several personnel need to access the same NETool repository from different
computers

e automated company file backup is required

e you want different repositories for different projects

It can also be convenient to operate with several repositories a user wants to alternate
between.
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Changing the repository location does not relocate NETool repository files by itself. If it
is desired to transfer the content of the previous repository location to the new location
then the files and folders must be moved manually. It is recommended that IT personnel
perform repository move or copy operations in order to minimize risk of losing files or
corrupting the repository.

Repository location can be changed by the following actions:

Modifying the configuration file as described below. If the NETool installation is shared
between several users this would define new default repository location(s) for all users.

A user can interactively change the repository location in the user interface. Go to
Edit->Preferences> Folder for User Files menu and select/enter the new database
location. Entering a blank value will restore the default.

Repository Content

The subdirectories in the repository make an organized hierarchy of user files.

When NETool starts, it reports into the console window the location of the file
repository:

i - =T
@ Select Console: NETool b@lm

METool GUI: C:“Program Files (xBE)\Landmalk\NETnulSEBB B.@_8~bhinwnetool. jar
Java UH: C:sProgram FilessJavasjrebshinsjava.ex f
dNETDDl Core: C:wProgram Files (xBﬁ)\Landmalk\NETDulSEBB B.8.8%hin“windousb4d~nt
11d.exe
—MHNETool Well Simulator Core version 5088.A.8.0-hetad (Z2018-11-02> [Windowsh4]
[Running on: x86_64; Windows 7 vb.1 SPB; msvert.dll-7.8-6.1; flexlm—11_.41
[Executable: CG:“wProgram Files <(x86)-Landmark:METool5888.0_8._8“bhin“windouwsb4x11i
bnetool.5k.B.d111
—MNETool Well Simulator User Interface version HHPBA.B.8.8-hetad (2018-11-82)>
[x86_64; Windows ? 6.1; Java 1.6.8_28 (http: - java.sun.coms3; 455 MiBl
WILL STORE USER FILES IM:
"Gislsersshh32185 _HALAMERI CAsAppDatasRoaming“NEToo 15"

=g

External plugins:

Figure 14. Repository location.

Note: Under Windows XP and Vista some directories are hidden by default. In order to
view it may be necessary to allow viewing hidden directories/files under Windows. The
hidden directories/files may be viewed by right clicking on the relevant directory,
choosing “properties” and unchecking the “Hidden” box.

Under the main directory of the file repository, a subfolder reservoirs\ is created. This
directory contains various reservoirs in separate subfolders of reservoirs\. Each reservoir
directory includes the following subfolders:

grid\ — a copy of the original files used when the reservoir was imported (e.g. .INIT,
.EGRID, etc.)

netool grid cache\ — grid and reservoir data in NETool format with small file size for
faster loading

wellcases\ — the case files for each well

5000.0.1.0 Page 27 of 113 2012



Landmark NEToo0l™ User Guide

Terminology: Reservoirs/Projects and Well Cases

Reservoirs/Projects

e NETool simulations are grouped into Projects. One project is typically for the same
reservoir and the top grouping level is therefore named Reservoir/Project.

e Three main approaches to establish a Reservoir/Project:

Create Gridless Project. Does not require a reservoir simulation model. Data is
imported from Spreadsheets, Logs and/or Manual Entry.

Create Project based on Imported Reservoir Model. A collection of reservoir model
files containing grid block dimensions, permeability, porosity, net-to-gross, PVT data and
other reservoir properties can be imported.

Combinations of the above. Override or supplement data in the Reservoir Model.

NETool supports reservoir grid files in formats created by the Eclipse reservoir simulator.
Once a collection of Eclipse files is imported into NETool (see below) a
Reservoir/Project has been created.

Well Cases

Within each Reservoir/Project multiple Well Cases can be created. Each Well Case
contains the following information:

well path

well segmentation

PVT/RelPerm/Lift tables and other fluid properties data (see Fluid Properties View)
properties of each segment in the well path (see Segment Settings/Completion View)
general model parameters (see Global Settings View)

other data like the name of the reservoir, preferred unit system, etc.

In other words, a well case is a collection of all the parameters that a user can modify
within NETool and describes the full work done by the user.

After a reservoir is imported and a well case is created, a NETool simulation of the well
case can be performed.

Manage Reservoirs/Projects and Well Cases

Reservoirs/Projects and well cases can be managed by launching File=>Open to open the
Open Reservoir and Well Case window: The same window is also always opened
automatically when NETool is launched.

The window consists of three sections:

Select Reservoir or Project section — shows a list of reservoirs and gridless projects
currently in the repository. The Add Reservoir button is used to add a new gridless
project or a new reservoir.

Select Restart File section — offers the user to import associated Eclipse restart file(s) if
an Eclipse simulation model already has been imported.
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Well case section — This section offers the user three main alternatives:
Start a new well case

Open an existing well case

Load a well case from another location than the current NETool repository

u@ Open or Create Well Cas

1. Project Type 3. Well case for reservoir "CASE_EG"
i r

) Gridless |_J Create a new well case

(=) With reservoir model (®) Open awell case from NETool database
Q Open a well case from file system

2. Reservoir Model
7

4. Select a well case from NETool database

% Resemvoir Model Run Date Restart Solution
BIGFIELD 2004-01-01 “w # Date Days Last Modified

BIGOIL 005.01-01 SO iaATa : 2010-08-21 12:17:50
CASE_E3 2010-06-01 2010-12-31 : SOiEUE SR Eh
CASE_E4 2010-04-10 2010-12-31
2010-12-31 2010-12-31
COP Well X.J24-... 2010-12-31
COP Well XJ30-... 2010-12-31
FEL_4B_MACR... | 1973-06-01 2010-12-31
MODEL55 1994-11-01 7 | 2010-12-31
Problem_case 02 | 2010-12-31
T 2000-01-01 2010-12-31
XJ302EBASE_2... [ 1995-10-15 2011-01-01
arwa 2008-01-01 2011-01-01
bad 1995-10-15 2011-01-01
homogenious 2004-01-01 2011-01-01
homogenious1 2004-01-01 2011-01-01
lono horizontal 2003-n1-n1 LT 2014010

| & AddResenvoir Model |

[ i Delete selected resemnvoir model ] [ 1 Delete selected wellcase J

OK Cancel .
Figure 15. Example of Open Reservoir and Well Case Window

NETool is shipped with some predefined sample reservoirs (BIGOIL, BIGFIELD and
Homogeneous) that will be listed also when NETool starts for the first time.

These predefined reservoirs can be used if one for reason does not want to create a
Gridless Project. In that case remember to override the reservoir parameters and fluid
properties within the model by populating the NETool model with log data, manual input
and/or utilize NETool’s built-in PVT and Relative Permeability correlations.

Creating a Gridless Project

A Gridless project can be created in the Open Reservoir and Well Case window and by
choosing Gridless project.

For a gridless project all reservoir properties must be supplied by the user. The data can
be specified manually, copy-pasted from spreadsheet or other applications, or imported
from logs, or alternatively created by NETool’s built-in correlations.
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The built-in correlations can generate PVT and Relative Permeability data based on
limited information.

Importing Eclipse Reservoir

A Reservoir/Project based on a reservoir simulation model can be created in the Open
Reservoir and Well Case window by choosing Add reservoir =>Import reservoir
model in Eclipse format.

The Import Grid Wizard is launched and the user is requested to submit reservoir
simulation model files sequentially.

Please note that when importing an Eclipse .INIT file, a corresponding Eclipse binary
grid file is required. The Eclipse binary grid file can be in the extensible grid file format
(EGRID) or in plain Eclipse grid file format (GRID). If both .EGRID and .GRID files are
supplied, the .EGRID file will be used.

However, some Eclipse reservoir simulation features are currently not supported in
NETool, e.g. the present version of NETool_cannot import:

Eclipse grids without inactive cell data. This applies to .GRID files only, and the
problem is avoided by specifying the record

GRIDFILE

2/

in the Eclipse .DATA file.

If Eclipse restart files (UNRST and .Xnnnn extensions) are present in the folder with the
JINIT file, they are highlighted and the option to import restart files is presented to the
user. Restart files contain e.g. pressure and saturations for each grid block for specific
points in time.

Please refer to Eclipse documentation for more details on Eclipse file formats.

After a reservoir model is fully imported, it will appear in the list of Reservoirs/Projects,
and it is saved as a NETool internal binary format. The internal binary format is used to
reduce file size and load speed compared to the voluminous Eclipse files.

Exporting Reservoir

If you would like to share a NETool reservoir with other users, choose i Export
NETool binary grid from the File menu. This will export your reservoir grid with
properties and save it as a file (with suffix .ntlgrid) that you can submit e.g. by email.

Since exported NETool grids are binary files, it is not useful to open these files with a
text editor.

These NETool binary grid files can be imported into NETool with File = Open = Add
reservoir model.

Creating, Opening and importing Well Cases

Select the correct Reservoir/Project in the list of Reservoirs/Projects. Three options will
then appear at the right hand side of the dialogue box:
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Start a new case. This will create a new well case with empty well path, default values
in Global Settings. In most cases, these default values should be treated as not being
reasonably describing your own specific data. There are no universal defaults good for all
situations!

Open the Reservoir & Well screen to define the well path and subdivide the well into
segments.

The next step is to populate NETool with reservoir properties and completion
configurations by using the Segment Settings / Completion screen.

If available in the Eclipse file dataset, PVT and relative permeability tables will be
imported if Eclipse files are imported. If not imported from the Eclipse file dataset, some
default tables will appear. However, your real PVT and relative permeability data can be
generated from other sources and copied into NETool through Fluid Properties.

The PI model and simulation control parameters are defined in the Global Settings
screen.

To save the new well case choose File © B Save or a corresponding button (H) in the
toolbar. Once the well case is saved you will be able to see it in the list of well cases in
the File Open dialog box.

Open saved well case. Open a saved well case.

Import a well case. In order to facilitate exchanging of data between users there is an
option in NETool save a well case into a user-specified folder instead of Netool database.
These files have a suffix .ntlcase. If you have a well case exported from NETool as
described above, import it into your NETool setup with the File = Open. Please note
that it makes sense to import a well case only if it has been created for the same reservoir
that appear on the left hand side part of the File Open dialog box.

Note: NETool will try to enforce this by comparing the names of reservoirs. For example
if a user Joe has a reservoir “JoesField”, then he creates a well case and sends it by email
to Mary. If Mary has a reservoir “MarysField”, selects it and tries to import the wellcase
NETool will show a confirmation dialog “The reservoir name stored in well case is
"JoesField " which is different from " MarysField". Are you sure to proceed? ” If
MarysField is the same reservoir as JoesField, just named differently, Mary should
choose OK, otherwise Cancel.

Deleting Reservoirs, Projects or Well Cases

Delete Reservoir/Project
To delete a Reservoir/Project, select it from the list and click the Delete Selected

Reservoir button. If the Reservoir/Project was created by the user it will be deleted
completely and will disappear from the list of available reservoirs.

If you are trying to delete a sample reservoir that was shipped with NETool or a reservoir
created by your system administrator, then only well cases and custom PVT/RPT tables
will be deleted. The “grid files” will remain and the reservoir will still be listed as an
available reservoir.

Delete Well Case
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To delete a well case, select the well case and click Delete Selected Well Case.

Saving Well Cases

To include the current well case to the NETool repository use File>Save Well Case As
or File->Save Well Case.

It is important to conduct the save operation since a well case is not part, or updated, in
the NETool repository until the save operation is performed.

Exporting Well Cases

A well case can be shared with other users by saving it into a user specified folder. This
will export your current well case and save it as a file (with suffix .ntlcase) into your
chosen folder location.

Please be aware this features do not save the well case to the current NETool repository.

Running NETool in Simplified (Training) mode.

It is not easy for a beginner to get acquainted with NETool because of the volume of
different input and output parameters. To aid with start-up a simplified mode has been
developed. It can be launched through a shortcut in windows “Start” menu (or by adding

“-s” key to run_netool.exe.).
- J INTEMWISE

Control Panel

In this mode most of the
regular input and output
parameters are hidden from
the user. Although it creates
lots of functionality

| Landmark
Landmark MET ool 5000.0.0.0 : :
— - — g 10 P rinters
||m| MET ool Well Sirnulator — Simplified Training Mode
I NET ool Well Simulator

Default Programs

.. . . m Plots Viewer
restrictions it helps beginner B Petosce Notes
to understand fast the basics = _ Help and Support
of the software. This mode is 22 Techmcal Marial
especially  helpful  for i Her Gt =
training classes. 1 Back
| Search programs and files j o |

Figure 16. Launching NETool in Training mode.
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Figure 17. Simplification of input and output in “Training” mode.
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Reservoir & Well Menu

e This section describes the features within the Reservoir & Well Menu. The menu is
displayed when the Reservoir & Well tab is selected in the bottom left corner. An
example is given in Figure 5.

Introduction

e The menu visualizes well and reservoir data, and facilitate entry of well paths and
well segmentation:

Well paths can be defined by three alternative methods: 1) import of deviation survey
data, ii) import of UTM coordinates or iii) interactively by clicking and dragging with the
mouse in the graphical views. The well path is represented by a collection of Trajectory
Points.

Well segmentation subdivides wells into segments. The segment boundaries are defined
by Nodes within NETool. A segment contains constant reservoir and completion
properties within the entire segment. Properties can be different from segment to
segment.

The menu can be operated in two main modes. This is controlled by the Show dropdown
box:

Trajectory must be selected to work with well path definitions
Segments must be selected to work with well segmentation
The menu display has four main areas:

The section on the left contain details of well paths (trajectory points). This is the main
area for entry and maintaining well paths.

The uppermost graphical panel shows a lateral, birds-eye view of the reservoir and the
well path. If a reservoir grid is present the view will show reservoir simulation grid layers
and their respective reservoir properties. The view can also be used to interactively move,
add and delete well trajectory points and nodes horizontally using the mouse.

The middle graphical panel illustrates a cross section of the reservoir along the defined
well trajectory. If a reservoir grid is present the view shows detailed property
distributions for the cross section along the well. The view can also be used to
interactively move well trajectories vertically using the mouse. Nodes can be altered
similarly along the well path.

The lowermost graphical panel displays completion types used in the well. If no
completions are defined yet (no segments) the panel is empty.

The section on the right is present if a reservoir grid is loaded. It lists the reservoir grid
blocks intersected by the well. The section is not available in a Gridless Project.
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Graphical Panels

The two graphical views can display the well path, the well segmentation and the
reservoir grid with properties. If the Well Case is for a Gridless Project only the well
path and well segmentation will be displayed.

The upper graphical panel shows a horizontal, birds-eye view of the well and reservoir.
The lower panel shows similarly the vertical cross-section along the well path.
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Figure 18. Example of Graphical Panel

A reservoir property such as permeability, porosity, saturations, pressure, active cell and
so forth (depending on the content of the imported reservoir simulation model) can be
displayed in the graphical panels by colored reservoir grid.

The available properties for display can be selected in the Reservoir Data dropdown
menu.

The reservoir properties can be presented as the average along the Z-axis or for each
individual layer by using the Layer drop down menu.

Zooming is possible for both graphical views. The zooming actions act independently for
each view. Use the right mouse button to define a rectangular area and then click %
Zoom to selection. The view will be updated so that the selected area will occupy the
whole screen. To view the whole reservoir, click # Zoom to Screen.
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Inspecting orid.

Due to MAPAXES keyword in Eclipse files grid coordinates exported from Eclipse or
other software might not match the real UTM (or Geographic) coordinates well trajectory
is in. For example, in GRID coordinates the origin can be at the beginning of the
reservoir and all reservoir blocks will have 2-3 digit coordinates, while in Geographic
coordinates the origin is often hundreds kilometers away causing grid blocks to have 5-6
digit X, Y, Z.

To switch between short (GRID) and long (Geographic) formats use “Coordinates”
switch on top of the reservoir panel.

“Inspect gridblock” button allows to further investigate coordinates and properties of any
grid block. “Top” section of the coordinates corresponds to the upper four points in
Corner Point Geometry: I, I+1, J, J+1. The “Bottom” contains the same corners except at
K+1 instead of K.

- Define Gridblock
=46 = J=|70 |~ K-|4 |+ Coordinates:|Grid v | | |GetData |

rGridblock Data— [ Gridblock Center — Grid Coordinates. Units: [fi]

Pressure | 2701.2758 X Y D
Kx 0.25364181 2040.68 | 7735.1 | 6193.35
Ky 0.25364181 [[4]
Kz 0.12682091 '
K;"*T_JII 5 493;555?? -Gridblock Corners — Grid Coordinates. Units: [ft]
oi ¢
S water |0.50983423 & X i
PVT Region 1
Sat. Region Fd
Swco 0.32843
Sorw 0.13500001
Swcr 0.32843
Sw_max 1.0
Krw_max |0.34999999
Porosity 0.2271685
HetiGross 1.0
Active yes
Flat no

1]

Figure 19. Inspecting grid blocks in detail.

Note: Netool does not have any editing capabilities for grid files. Grid is imported and
stored as read-only. If user needs to use values different from the grid at some location
(fiex. permeability) he should switch that property to “Manual” instead of “From grid” in
“Segment Settings->Reservoir Parameters” and enter desired value.
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Working with Well Paths

Definition of the well path is performed in Trajectory mode. Trajectory mode is
activated by the Show drop down box located on the top left in the Reservoir & Well
screen. The well path cannot be modified in the Nodes mode (which is the other
alternative in the Show dropdown box).

The well path constitute of trajectory points linked together. There are three ways to
define a well path in NETool:

e Interactively with a mouse and/or keyboard
e Copy-pasting deviation survey

After the well path is defined consider to activate the Locked checkbox to make sure that
the well path will not be altered accidentally.

Creating and Changing Well Path Interactively

Well paths are created by clicking within the grid in the top window to create trajectory
points. Simply click (left mouse button) several points and the well is created. Trajectory
points can also be moved by dragging the points - click and hold down left mouse button,
move mouse and release mouse button when the trajectory point is in the appropriate
location.

Moving the trajectory point in the upper window moves the trajectory point horizontally
(x-y directions). To adjust the depth (z direction) of the trajectory point, drag the
trajectory point vertically in the lower window.

Additional trajectory points can be added between existing trajectory points by clicking
on the white line in between defining the well path.

Right clicking on a trajectory point will bring up a menu which allows the user to:

Remove Trajectory Point — remove that point from the well trajectory. NETool will
then calculate a new trajectory between the remaining points, or shorten the well if this is
the last trajectory point.

Start New Lateral — a new lateral will be started off of the current trajectory point.

Importing Well Trajectory

Two alternatives are available to import well paths:

Supply UTM coordinates - equivalent to 1) x,y,z or ii) easting, northing, TVD

Supply Directional Survey data - as MD, inclination, azimuth

The well path import is accessed on the left side of the Reservoir & Well panel or from
the menu Edit = Well Trajectory & Nodes.

UTM Coordinates

Step 1 — Define and Edit Well Trajectory

The Well path can be defined by 1) typing or ii) pasting the x,y,z coordinates of trajectory
points into the Trajectory text field.

Values turn blue when they are edited.
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When a reservoir grid is used it is important to use the same coordinate offset for the well
path and the reservoir grid such that the trajectory will be at the correct location within
the grid.

Step 2 — Update Trajectory

After the trajectory is entered or edited, push Update Trajectory button to update the
trajectory information.

Step 3 — Define MD Reference Depth (Heel MD)

The measured depth for the first x,y,z coordinate point in the NETool model is defined in
the Heel MD text area. NETool treats this first point as the top of the NETool model.

Deviation Survey

Select Enter Directional Survey to open the directional survey import screen. This
screen will define the directional survey and calculate the well path based on the survey

data.
5I
il Edit

UTM coordinates of the first survey point

X (East) [ft] ¥ {North) [ft] Z (TWD) [ft]
18732740 2.12078e+7 -100

Directional Survey

MD [ft] Incl. [deq] Azimuth [deg]
0 0 0 -
&0 0 0 _
100 1 300 |
150 2 310 —
Heel MD: [2400] | ]

Import Well Trajectory as Survey Data

The top ine shows the %,7.7 co-ordinates of the first survey point. Thiz point
cat be any point on the survey at or above the heel in NETool. For example the
position of rig floor can be entered along with TVD of zero if the survey is

ok | concol

Figure 20. Example of Import Directional Survey Window

Directional survey data is a collection of (MD, Inclination, Azimuth) at different depths.
MD can be in either [f¢/ or [m]. To change units, exit this menu and choose Units from
the top menu bar. Inclination and azimuth must always be in degrees (azimuth is in 0-360
degree format).

Note: When using data derived from actual logs, importing the well path as a directional
survey keeps the logs on depth. If the well trajectory is later modified using the graphical
facilities of the reservoir view, logs may no longer be on depth.

Step 1 — Define location of the first survey point
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Enter the x,y,z coordinate of the first survey point at the top line in the window.

An example, if the rig floor is the position of the first survey point then the coordinates of
the rig floor must be supplied. If this is an offshore rig the z coordinate typically will be
negative since the sea surface normally is at z = 0.

It is very important to get this right such that the well is located correctly in the reservoir.
A wrongly defined top UTM coordinate leads to wrong position of the well in the
reservoir.

The x,y,z position of the well will default to the centre and top of the reservoir (for
convenience when using the BIGOIL or other predefined reservoir grids in the absence of
your own Eclipse grid).

If you are using an Eclipse file from your reservoir, the position of the top node should be
entered with the offset included in the Eclipse file.

Step 2 — Define all survey points
Supply the entire deviation survey set (MD, inclination, azimuth) by either 1) file import
or ii) copy-paste into the text area.

Step 3 — Define Heel MD of deviation survey

A complete survey dataset is necessary to locate the well correctly downhole. However,
NETool’s model region should only constitute the part of the well that covers the
reservoir section (NETool is currently not designed for detailed simulation of flow form
reservoir to the surface). Consequently the trajectory from the top down to the reservoir
should be removed after the well location downhole has been defined.

In order to remove the trajectory data above the reservoir section the Heel MD needs to
be entered. Heel MD in this context will define the top of NETool modeling region, and
it should be approximately at top of the reservoir.

To sum up: Survey data above Heel MD is only used to calculate the x,y,z location down
to the heel. The data above the heel will not be included in NETool after the x,y,z
coordinates have been calculated..

Step 4 — Calculate Trajectory coordinates

After OK is pressed on this screen, the well path in are calculated in x,y,z coordinates.
NETool does not save the survey data itself after the x,y,z coordinates have been
calculated. It is the remaining x,y,z coordinates that will be kept.

Step 5 — Update Trajectory
In order to update the Trajectory after the x,y,z coordinate calculation has been conducted
select Update Trajectory.

Define Heel MD (Top NETool Model node)
NETool treats Heel MD as the top of the NETool model (the models first point).
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The top of the NETool model should normally be quite close to the top of the reservoir
since NETool is not designed for detailed modeling of the flow from top completion up
to the surface.

This is also the reference location for NETool’s report of BHP. It can therefore be a good
idea to let Heel MD coincide with the bottomhole pressure gauge or the pressure
reference depth.

If Heel MD is changed only the reported measured depth of the well is changed; the
calculated results are unaffected and the well stays at the same location in space.

Create and Change a Multi-Lateral Well Path Interactively

NETool can model complex multi-lateral wells. Multiple laterals are allowed as well as
sub-laterals (in an endless fashion actually). All the capabilities to define and model well,
completion and reservoir properties for the Mainbore apply to Laterals.

The lateral to be edited is selected in the Wellbore pull down menu located close to the
top-left corner in the NETool window. When a well case is created there is always only
one Wellbore named “Mainbore”.

To create a lateral, just right click on the trajectory point where the junction is located,
and choose add lateral. An alternative way to add as lateral is to push the Add Sublateral
button in the left-bottom corner. NETool will automatically enter into the mode of editing
the new lateral. This menu allows the trajectory of the lateral to be entered in a similar
manner as for the Mainbore.

Lateral can be removed with the Remove Lateral button on the left hand side.

Remove Mainbore button deletes the entire well. When viewing a lateral the button
display Remove Lateral x.x — and then the particular lateral is removed.

Add Sublateral adds a lateral to the active well trajectory as selected under Wellbore.

An effort should be made to have the lateral junction at a survey point in the Mainbore
survey. If the top node of the lateral is not exactly a point on the Mainbore survey,
NETool will choose the nearest point in the Mainbore survey as the junction and modify
the position of the top of the lateral, or give an error message if the top of the lateral is
not sufficiently close to the Mainbore.

When the lateral is imported as a deviation survey, it is best to choose the junction as an
MD on the Mainbore with a trajectory point available — or assign a trajectory point on
the Mainbore at the junction. If the top measured depth of the lateral survey is not a
trajectory point on the Mainbore, NETool will either move the junction to the nearest
trajectory point or add a trajectory point to the Mainbore at the junction.

Lateral Junctions Configuration

Five different junction types are available in NETool. The junction type for a simulation
is chosen in the Segment Settings menu: Segment Settings>Hole &
Completion->Lateral Connection:
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To Tubing: lateral tubing is connected directly to mainbore tubing

To annulus (Stinger): lateral tubing is connected to mainbore annulus outside Stinger
layer. This option is visible only when Stinger is present at the junction location.

To annulus (Inflow Control): lateral tubing is connected to mainbore annulus outside
Inflow Control layer. This option is visible only when Inflow Control is present at the
junction location.

To annulus (Sand Control): lateral tubing is connected to mainbore annulus outside
Sand Control layer. This option is visible only when Sand Control is present at the
junction location.

To annulus (Casing/Liner): lateral tubing is connected to mainbore annulus outside
Casing/Liner layer. This option is visible only when Casing/Liner is present at the
junction location and has Blank Pipe or Slotted Liner completion type.

Working with Sesmentation

The next step after the well path is defined is to subdivide the well into segments. A
segment is a part of the well with the same/constant reservoir and completion properties
along entire segment length.

Segment boundaries are defined by nodes. Nodes are points along the well path.
Creation and deletion of nodes can be performed numerically or graphically.

The active lateral to be edited is chosen with the Wellbore dropdown menu located on
the Reservoir & Well Trajectory tab in left upper corner.

Well segmentation is performed in the Segments mode. The segmentation cannot be
modified in the Trajectory mode (which is the other alternative in the Show dropdown
box).

Nodes should mostly be created and deleted from the Segment Settings / Completion
panel, but it is also possible to create and delete nodes from:

e Graphical panels showing well trajectory

e Completion plot

e Log views.

¢ Create Segments button
Once the segments have been created, they appear in the Segment Settings/Completion
sheet.
Well Segments panel allows the following operations:

e Modification of segment MD (select desired row and type a new number)

e Deletion of a segment interval (select row and press “delete” button)

e Insertion of a new segment (type desired MD in an empty row at the bottom)

Update MD must be pressed after each of these operations.
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Nodes can be moved along the well path interactively in the graphical views or
completion plot by dragging. Dragging is performed by left clicking and holding on a
node, move the node to the desired position and release the mouse button.

After the segmentation is defined, consider to activate the Locked checkbox to make sure

that the well path and segmentation will not be altered
accidentally.

Creating segments automatically.

Create Segments button is located in lower-right corner of
Segment Settings/Completion screen. It allows to:

e (reate a quantity of equally spaced nodes
e Create nodes at even spacing

With each of the automatic node creation options, the user has
the option to delete the previous nodes (default option) or to
retain the existing nodes and add additional nodes.

2. Once the nodes have been created, choose Update Nodes
MD to assign these nodes in NETool. You can also click
Cancel if you accidentally create an undesirable node.

Packers button allows to automatically add/remove packers
on different completion layers between all segments. This
option is useful when user needs to create a large amount of
packers. It is usually easier to delete unnecessary packers
afterwards then to create everything manually.
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Global Settings Menu

General

The General tab is used to define these settings:
Well type — oil producer, gas producer or injector
Phase Mode — basic combinations of oil, gas and water

Boundary condition (or Simulation Target) — bottom hole pressure, tubing head
pressure, various flow rate targets, IPR

Hydrostatics — Specify hydrostatic effects
Reservoir Pressure — Specify how to calculate hydrostatics in reservoir.

Pressure drop in tubing — correlations to be used inside the wellbore Homogeneous,

Beggs and Brill, Aziz, Duns & Ros or OLGAS
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Figure 21. Example of a General tab in the Global Settings Menu
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Well type

Three options are available:

Producer — a producing well

Injector, water — a well injecting single-phase water.
Injector, gas — a well injecting single phase dry gas

Note: For the two injection well types, it is assumed pure gas or water flow, and that the
relative permeability to the flowing phase is 1 (one). Mobilities under Reservoir
Parameters on the Segment Settings/Completion Screen are not used and are unavailable
when injection well is selected.

Phase mode

Any combination of oil, gas and water phases can be selected for a Producer.

Target for producers

NETool allows several options of Target rate/pressures as the outlet boundary condition:
Flowing BH Pressure: Specify the flowing Bottom Hole Pressure at the heel node.
Tubing Head Pressure: Specify the flowing Tubing Head Pressure. The lower bottom
hole pressure limit and gas must be defined. Lift curves must be in the in the Eclipse type
format and shall be entered in Fluid Properties -> VFP.

Total Reservoir Rate: Specify a total volumetric downhole flow rate in reservoir.

Total Liquid rate: Specify the desired flow rate of liquid in volumes at standard
conditions.

Oil Flow Rate — Specify the desired flow rate of oil in volumes at standard conditions.
Gas Flow Rate — Specify the desired flow rate of gas in volumes at standard conditions.
None, Make IPR — NETool will generate an IPR curve for the pressure range specified in
the number of step specified. With this mode, pressure and flow rate charts are not
generated in the output.

Calculate THP. This check box is available when Target is other than Tubing Head
Pressure (THP). If checked NETool will use VFP tables to calculate THP corresponding
to the BHP or rate target solution. The calculated THP is then shown in the Results
Summary Table.

Table 1: THP Results Summary

Summary Tahle
€ D E F 6 H | J K L 1]
Phase mode| OQilrate Gasrate |Waterrate| GOR WCUT LGR Q res. total BHP THP Gas Lift Rate
Three phase [3562.39716 | 157522744 0 442181871 0 000226151289 (9216.38773 | 268.8053151 | 52.24772443 0
Bm3id] | MMSm3id] | [Bmaid | [Sm3iEma] %] [5m3ISma3] [Rmad] [Bar] [Bar] [MMSm3rd]

With some Targets an additional THP vs. BHP plot will be generated if the Calculate
THP box is checked.

For tubing head pressure calculations, lift curves in the format generated by Prosper™
must be entered in Fluid Properties -> VFP.
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Gas Lift Rate. This input field is available when 1) Target is Tubing Head Pressure or ii)
the Calculate THP box is checked. Gas Lift rate can be used with VFP curves includes
gas lift. This input value is ignored if the VFP information does not include gas lift.

Hydrostatic
Several check boxes are used to control NETool hydrostatic pressure effects due to
varying vertical depth TVD along the well.

Use Hydrostatic - when checked, the effect of vertical differences along the well are
included in the NETool calculations.

If reservoir grid is not present or contains inconsistent values user may want to use
reservoir pressure at a certain point and let NETool recalculate hydrostatic difference.
This functionality is included for convenience so that the user does not need to manually
adjust every reservoir pressure for hydrostatic differences along the well.

There are several options available through Reservoir Pressure from switch (It appears
only when Use Hydrostatic is ticked.):

e Defined Along the Well for Each Segment - Netool will use values from ‘Segment
Settings—Reservoir Parameters—Reservoir Pressure‘. It assumes proper reservoir
pressures are entered along the well.

e Single Value at Heel + Hydrostatics - NETool takes pressure at BH location in
reservoir and recalculates reservoir pressure profile based on vertical difference from the
heel and fluid densities flowing into the wellbore.

e Single Value at Some MD + Hydrostatics - NETool takes pressure at some MD
defined by user and recalculates reservoir pressure profile based on vertical difference
from the heel and fluid densities flowing into the wellbore. This option is useful if vertical
well penetrates a thin production zone.

Pressure Drop in Tubing and Annulus

NETool currently offers five options to calculate fluid flow performance in the tubing
and open annulus:

Homogenous — uses a single phase flow correlation as commonly used throughout the oil
industry using average properties of the phases present in that section of the well.

Beggs & Brill — uses the two phase (gas/liquid) flow correlations as published by Beggs
and Brill. This correlation is the best for horizontal pipes.

Aziz, Govier, Fogarasi is based on publication “Pressure Drop in wells Producing Oil and
Gas” by the same authors in the Journal of Canadian Petroleum 72-03-04.

Duns, Ros is based on “Vertical flow of gas and liquid mixtures in wells” by
H. Duns Jr. and N. C. J. Ros WPC 10132 1963.

OlgaS — the OLGA-S options only appear when the OlgaS.dll from Scandpower is
available. This dynamic link library is an add-on feature to NETool.
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Aziz and Duns&Ros models are applicable only to vertical flow in a pipe if liquid and
gas are present. Therefore if selected by user they will be applied only to segments which
satisfy both conditions:

Inclination is 45-90° to horizontal.
No annulus flow.

If a segment does not satisfy these conditions it will use “Homogenious” pressure drop
model.

BJ BQ BR
Well Pressure drop | Grid I,J,K
Inclination | correlation
["deq]
26.5763 Duns Ros 0,00
265763 Duns Ros 0,00
28 5593 Duns Ros 0,00
28 5593 Duns Ros 0,00
28 5593 Duns Ros 0,00
28 5593 Duns Ros 0,00
325363 Duns Ros 0,00
32 5363 Duns Ros 0,00

Figure 22. Pressure drop correlation is reported in “Details”.

In order to simulate vertical lift performance using these models user should set “Target”
to BHP or any Flowrate. Setting “target = Tubing Head Pressure” will enable imported
lift table usage from the heel to the surface.

PLT

An option to enter PLT data (water flowrate, total downhole flowrate and pressure as a
function of MD) is available. Toggle on Overlay output with PLT data check box and
click the PLT Data button, enter data or copy past from other sources as for instance a
spreadsheet. PLT results are presented together with simulated results for the tubing in
the Plots viewer.

Inflow (PI Models)

Productivity Index models are selected and configured in the screen Global
Settings=>Inflow. Pls are normally calculated locally for each segments based on
individual segment’s properties.

This section presents an overview of the PI model options and configurations. Vertical,
horizontal and deviated PI models are discussed in more detail in the NETool Technical
Manual.

Well PI dropdown menu

Auto is the default option, which facilitate calculation of all the local PlIs based on
reservoir properties and configuration of PI models
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Manual is an option where the well’s total PI is supplied by the user. Local PIs for each
well segment will be scaled according to local permeabilities so that the sum of local Pls
is equal to the total PI entered. This option can be good if you want to tune the NETool PI
to an observed PI from well test. The sum of local PIs are scaled to match the total PI.

Set PI model for each segment checkbox

Box unchecked (default): PI parameters for the whole well are defined as described
below.

Box checked: PI parameters can be specified for each segment individually in the

Segment Settings/Completion menu using the folder Reservoir Parameters
- Transmissibility—=>PI model.

PI Model Type dropdown menu:

Steady State: This mode is appropriate when there is full pressure maintenance of the
reservoir. It assumes constant reservoir pressure versus time and the models assume
constant pressure boundaries.

Semi-Steady State PI Model: This mode is appropriate for reservoirs experienced
pressure depletion. It assumes a constant pressure drop versus time throughout the
reservoir.

A summary of the input parameters for vertical and horizontal PI models is supplied in
the Table 2 and Table 3.

Detailed configuration of the PI models is covered in the next sections.
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Table 2: PI Models for Vertical Wells - Input Parameters

Reservoir State

Input items

Steady state

Semi-steady state

Reservoir
Dimension

Radial extent

Circular region: Radial extent

Irregular region: Size of area &
shape factor

Pressure Status

Pressure at reservoir boundary,
or

Average reservoir pressure

Pressure at reservoir boundary,
or

Average reservoir pressure

Table 3: PI Models for Horizontal Wells - Input Parameters

Reservoir State

Input items Steady state | Semi-steady state
(Joshi) (Babu & Odeh)

Reservoir Reservoir Thickness in the | Reservoir Length

Dimension vertical plane and ellipsoid in | Reservoir Width
the horizontal plane where the R - Thickn
width of the ellipsoid is given CSCIVOIL L RICKNESS

Well Position In the center of the reservoir | Length position of well

Thickness and the ellipsoid

Width position of well
Depth position of well

Pressure status

Pressure at reservoir boundary
(ellipsoid)

Average reservoir pressure of
drainage volume

PI for Deviated Well Sections

NETool combine PI models for horizontal and vertical wells to account for the full range
of well deviations.

The following scheme when defining the PI model for the different well segments:
0-10° - Vertical Well PI model

10-80° - Deviated Wells PI - Combination of Vertical and Horizontal PI Models
80-90° - Horizontal Well PI Model

Steady State Models

Vertical PI Model
The Steady State Vertical PI model is used for vertical sections of the well, and assumes:
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Constant pressure boundary at radial distance from the well
Radial Darcy flow
Required input parameters:

Radial extent of reservoir: defines the distance to the constant pressure boundary.

Vertical PI based on: defines whether the vertical PI is based on average pressure or
external boundary pressure

Pres at Re: Vertical Well PI is calculated using Reservoir Pressure values as pressures at
the radial extent of the reservoir. This option is appropriate when manually entered
reservoir pressures are pressures at the radial extent of the reservoir, or when pressures
populated from the grid are pressures at initial conditions.

Average Reservoir P: Vertical Well PI is calculated using Reservoir Pressure values as
the average pressure. This option is appropriate when manually entered reservoir
pressures are the average reservoir pressures.

Discussion about configuration.

The appropriate value is dependent on i) type of supplied pressure and ii) size of the
reservoir.

Manually entered Reservoir Pressure Values — it is recommended to enter the radial
distance to the constant pressure boundary for the well.

Reservoir Pressure taken from the grid at initial conditions - this is the case for making
time=0 simulations of the well based on reservoir pressure values from the grid - the well
has not yet caused localized drawdown around the well. If the reservoir conditions are
such that pressure in the reservoir is well supported (steady state conditions), it is then
recommended to enter the actual drainage radius of the well, and set the choice Vertical
Well PI based on: to Pres at Re.

Reservoir Pressure taken from the grid/restart files after initial conditions - it is often
more appropriate to use the semi-steady state PI model for these conditions.

Horizontal PI Model
The Steady State Horizontal PI model is using the Joshi model for horizontal wells.

The Joshi model assumes that the well is centered in the reservoir. NETool distributes the
total PI along the well according to individual segment properties.

Configuration parameters for steady state horizontal wells are illustrated in Figure 23.
Reservoir Thickness: Is the vertical thickness of the reservoir (contributing to flow).

Reservoir Width: Joshi assumes a constant pressure boundary with a shape as an ellipse
in the horizontal plane where the well is located symmetrically. The reservoir width is the
width of ellipse forming the constant pressure boundary in the horizontal plane.

Netool assumes that well length is equal to reservoir length. (In other words Rend = 0).

Reservoir Pressure: Is the pressure at the constant pressure boundary.
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1
; Reservoir Pressure

Reservoir Width

WAL LLLlLLLLLLLLLLLLLLLL)

K
f*

Reservoir Length

Figure 23. PI Model Parameters for Steady State Horizontal Well (Joshi)

Semi-Steady State Models
Vertical PI Model

The Semi-Steady State Vertical PI model is used for vertical sections of the well, and
assumes constant depletion rate of the entire reservoir with radial Darcy flow equation
model for radial reservoirs, or the use of Dietz shape factors for irregular reservoirs

Drainage Region — has the following two options which trigger various sub-options:
Use circular drainage region

Radial extent of the reservoir
Vertical PI based on:

P at Re. Vertical Well PI is calculated using Reservoir Pressure values as pressures at the
radial extent of the reservoir. This option is appropriate when the reservoir pressures
entered manually are pressures at the radial extent of the reservoir, or when taking
pressures from the grid at initial conditions.

Average Reservoir P. Vertical Well PI is calculated using Reservoir Pressure values as
the average pressure. This option is appropriate when the reservoir pressure entered
manually is the average reservoir pressure, or when taking the reservoir pressure from the
grid when using a restart file at a future time.

Use irregular region

Drainage area
Drainage area shape - (Dietz) factor
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Discussion about configuration.

The Semi-Steady State PI model assumes a constant pressure drawdown through the
reservoir.

The appropriate value to enter here is dependent on where the reservoir pressure is taken
from and the size of the reservoir.

Manually entered Reservoir Pressure Values - it is appropriate to enter the radial distance
to the reservoir boundary. Also, ensure the reservoir pressure values are appropriate.

Reservoir Pressure taken from the grid with grid at initial conditions - this is the case for
making time=0 simulations of the well based on reservoir pressure values from the grid -
the well has not yet caused localized drawdown around the well. If the reservoir
conditions are such that pressure in the reservoir is not supported (semi-steady state
conditions), it is then appropriate to enter the actual drainage radius of the well, and set
the choice Vertical Well PI based on: to Pres at Re.

Reservoir Pressure taken from the grid from a restart file at future time - this is the case
for making future time simulations of the well with reservoir pressure taken from the
grid. In this case, there will be localized drawdown around the well. NETool will be
using as reservoir pressure the average pressure of the gridblock the well passes through.
It is appropriate then to set Vertical Well PI based on: to Average Reservoir P. The
drainage radius should be set to the Peaceman radius of the gridblock.

Horizontal PI Model

The Semi Steady State Horizontal PI model is using the Babu & Odeh formulation for
horizontal wells.

The Babu & Odeh model considers the position of the well inside a rectangular reservoir
box. The well is parallel to rectangular reservoir box but not need to be centralized in the
box. See illustration in Figure 24. Configuration parameters for Semi Steady State
horizontal wells are illustrated in Figure 24.

Reservoir Dimensions:

Reservoir Length — is the length of the reservoir in the direction parallel to the well.

Reservoir Width — is the width of the reservoir in the direction perpendicular to the well

Reservoir Thickness - is the vertical thickness of the reservoir (contributing to flow).

Well Position - the following items describe the Well Position in the reservoir:

Length position of well - is the distance from one of the end of the reservoir to the middle
of the well in the direction parallel to the well.

Width position of well - is the distance from the well to the extent of the reservoir in the
horizontal plane perpendicular to the well direction.

Depth position of well — the depth position is relative to the reservoir thickness, i.e. TVD
from top of reservoir.
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Reservoir Pressure — Is the average pressure

Babu & Odeh (Semi-Steady State)
Horizontal Well Pl Model Input Parameters

Depth Positj

N e T TPy D esees

of Well

Reservoir
Thickness 3

—Reservoir Width

Figure 24. Model Parameters for Semi-steady State Horizontal Well (Babu & Odeh)
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Advanced

This menu controls numerical parameters and is important for defining the accuracy and
handle potential numerical problems. Manipulation of the parameters below may help
solving cases that otherwise wouldn’t converge.

Precision of calculations

This sets the allowable numerical error. Reducing this term will make NETool more
accurate, but leads to longer run times and may lead to convergence problems.

Stability

The NETool solver cannot accept flow rates of zero in any part of the numerical network
being solved (all flow rates in NETool are limited to a small non-zero value). The
stability term sets the minimum flow rate allowed in NETool. This is the local flow rates
(local influx rates, local annulus flow rates, local tubing flow rates, local flow rate across
the completion, etc). For some very low flow rate cases, it is appropriate to reduce this
number as the very small flow rates may change the results.

A bit of thought on number of intermediate nodes for the well, such that areas of low
influx do not have large numbers of intermediate nodes can also help with both
“Problems with Decomposition” and “Unable to determine flow direction” errors.

A Stability value of 1 = 1E-8 Sm’/sec.

Flow can change directions

NETool automatically solves for flow directions inside the well. For some pressure
distributions, for example cross-flow situations can exist. To prevent NETool from
looking for such solutions uncheck appropriate check boxes.

Well Pressure Range
Three parameters are available:
Well Pressure Limit- Auto or Manual

Min well pressure (only available if Well Pressure Limit is Manual)

Max well pressure (only available if Well Pressure Limit is Manual)

By default, NETool automatically chooses the allowed well pressure range. This
operation is necessary for numerical convergence considerations. However, for
cumbersome cases with multiple laterals and cross-flow this may not work satisfactory.

If convergence problems is experienced, one remedy could be to define minimum and
maximum pressures manually (i.e. bottom-hole pressure as lower and maximum reservoir
pressure as upper limit) in order to assist in solving the case.

Momentum balance

Momentum balance has the following options:

Improved momentum balance — enables compressible Bernoulli model for completions
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Max Mach number — sets up the limit on how close to the speed of sound subcritical flow
can be.

Bernoulli for diameter variations- enables compressible Bernoulli model for annulus and
tubing diameter variations. Uses either upstream density (Approximate option) or average
of upstream and downstream (Almost precise)

Transitional flow regime

Low Reynolds — Lower limit for transitional flow in terms of Reynolds number. A
reasonable number is 2000.

High Reynolds — Upper limit for transitional flow in terms of Reynolds number. A
reasonable number is 3000.

Convergence Tuning
Options to control numerical calculations and convergence are:

Iteration step dumping — limits how fast variables can change between iterations.

Water derivatives - Controls water derivatives in the numerical solver. Using Switching
or Off will help to converge cases with high oil viscosity and uneven water inflow.

Smooth Pres over - Defines window size for moving average filtering applied to reservoir
pressure. Reservoir pressure usually exhibits unphysical jumps between Eclipse grid
blocks. This pre-processing makes pressure profile more physical and improves
convergence. Suggested to be 4-20 the size of a grid block.

Local density in hydrostatics - May help to reach convergence for cases with oscillating
wellpath or wrong reservoir pressure coming from large grid blocks.

Simplified Rs/Rv handling - Enables an old model for Rs and Rv used in Netool
v5000.0.0.1 and earlier. This model assumes a single average Rs and Rv along the well.
It's recommended to keep this checkbox selected as the new model is in testing stage.
Unselect this checkbox if your model contains more than one production zone.

PVT derivatives

PVT derives in MatBal

PVT derives in inflow acceleration

PVT derives in friction

PVT derives in completion

Enabling or disabling these options may help to reach convergence in hard cases.
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Output
This menu controls which plots and tables that should be produced by default, most of the

output items are turned on.
Annotation

This field is useful to provide detailed description of the well case. It is usually a good
practice to make an expanded description of important well cases for future
documentation and understanding.
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Fluid Properties Menu

The Fluid Properties Menu is used for viewing, adding or modifying:
e PVT data (required)

e Relative Permeability data (optional)

e VFP (Lift curves) data (optional)

The Fluid Properties Menu contains the tabs PVT, RelPerms, Lift to for selection of the
respective property submenu.

PVT data must always be present while relative permeability and lift curves are optional
and may be left out.

Relative permeability is required if mobilities are to be calculated from relative
permeabilities and saturations.

Lift curve(s) is required if the simulation is produced against the tubing head pressure
target.

PVT data and relative permeability data will be automatically imported if an Eclipse file
dataset is imported.

The Lift Curves (VFP tables) are normally generated with software such as Prosper. The
Lift curves can be copy-pasted into NETool.

PVT
NETool supports black-oil PVT formulation with dissolved gas, vaporized condensate
and multiple bubble/dew points.

Fluid properties can be supplied in two different formats: i) NETool’s PVT tables or ii)
Eclipse style PVT tables.

PVT data can be viewed, edited and entered from the PVT tab of the Fluid Properties
Menu.

PVT data can be prepared outside NETool for copy-pasting into the NETool input
window, or alternatively saved as a file and imported into NETool.

The PVT window has two tabs:
Oil-Gas PVT data
Water PVT data

The content of these tabs will depend on the chosen item in the “PVT data from” pull
down menu:

From PVT table — a table is shown. It is initially populated with an example set of
values. User is supposed to fill it correct data i) by copy-pasting from other program or
i1) by using PVT correlations.

From Eclipse INIT file — NETool will extract PVT data from the Eclipse INIT file and
present the content in the text area as Eclipse type PVT format.
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From PVT data in Eclipse format — shows a blank text area which allows user to enter or
paste data in Eclipse type PVT format.

PVT data used by NETool can be inspected graphically. To view PVT data plots choose
View—>Visualize PVT and RelPerms. Additionally, PVT data is always shown in the
output plots after a simulation. It is recommended to look at the PVT plots for every
new PVT table to have a first glance if they look physically reasonable. Wrong or
inconsistent PVT data can also lead to convergence problems in addition to wrong
calculations.

x

File Edit View
[ PVT [ RelPerms | Lift |

PVT data from: ‘Frnm PYT Tahle ‘v|

| Oil-Gas PVT data | Water PVT data

vaporized Condensate
Oil PYT with Multiple Bubble Points O
Wet Gas PVYT with Multiple Dew Paints l
P Rs Bo Vo Rw Bg Vg

[FSI1] [SCFISTE] [RE/STE] [cF] [STEMMSCF] [RCFISCF] [cF]
14.5037856 0.0 1.0 2.6 0.0 1.0 0.01
21754567841 (449166 1.3 1.0 17.8108 0.006R 0.018
4341135681 [A88.332 1.6 (N3] 356216 0.0033 0.026

Oil Density at ST cond. 28.5335 AP1®  Gas Density at ST cond. [0, 665509 gG to air

PYT Correlations ...

Figure 25. PVT Input Screen

PVT Correlations

The PVT correlations capability provides generation of PVT data based on limited PVT
information. Minimum required information are oil and gas gravities plus some default
water properties.

The facility is available when working in the From PVT Table mode. The PVT
correlations button is located below the PVT table. Selecting the button opens a new
window which allows the user to specify and configure the correlations.

After configuring the correlations PVT data can be generated by pushing the Generate
PVT button. The generated PVT data populates the PVT table.

Table 4 shows the simple industry-standard PVT correlations available.

Table 4: PVT Correlations
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PVT Parameter Correlation

Solution Gas Oil Ratio Standing

Bubble Point pressure Standing

Oil Formation Volume Factor | Standing

(P> Pyp)

Oil Formation Volume Factor | Standing

(P <Pyp)

Oil compressibility Standing

Dead oil viscosity Glaso

Saturated Oil Viscosity Standing

Undersaturated Oil Viscosity Standing

Pseudo Critical Temperature Sutton

Pseudo Critical Pressure Sutton

Gas Viscosity Carr et al, Dempsey,
Standing

Z-factor Hall and Yarborough

Gas Formation Volume Factor | Equation of State

Water compressibility Rowe and Chou

Water Viscosity Kestin

Water Density Rowe-Chou

Water  Formation Volume | Rowe-Chou
Factor

Qil and Gas PVT Properties

Oil and gas PVT are based on black-oil formulation. It also allows for vaporized oil,
condensate, wet gas, multiple bubble points and multiple dew points if desired.

Capabilities for 1) vaporized oil, ii) multiple bubblepoints and iii) multiple dewpoints are
controlled by the checkboxes shown in Table 4.

More PVT calculation details are covered in NETool Technical Manual.

PVT data can be produced graphically by Fluid Properties=> View-> Visualize PVT &
Relperms for inspection. The same plots will also be produced by NETool in the output
plots after a simulation.
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Oil PVT with Multiple Bubble Points

The check box Oil PVT with Multiple Bubble Points can activate multiple bubble point
capabilities.

When the option is activated the columns in the PVT table are split to distinguish
saturated and under-saturated regions for Oil Formation Volume Factor (B,) and Oil
Viscosity (o).

Rs, Bo,sat and Vo,sar columns in the table define saturated data as a function of
pressure.

Cousar and C Vi,usar columns define compressibility and viscosibility of
undersaturated oil.

Also the input for Rs will appear in the Segment Settings—> Reservoir Properties sheet.

When the Multiple Bubble Points option is not activated, NETool assumes that the Rg, B,
and V, columns in the table define the actual oil PVT data as a function of pressure.
Rg must be increasing up to the bubble point and must be constant at higher pressures
than the bubble point.

Vaporized Condensate

The check box Vaporized Condensate adds the Ry column PVT data. Ry contains
vaporized oil as function of pressure.

Wet Gas PVT with Multiple Dew Points

The check box Wet Gas PVT with Multiple Dew Points can activate multiple dew point
capabilities.

When the option is activated, the columns in the PVT table are split to distinguish wet
and dry gas for Gas Formation Volume Factor (Bg) and Gas Viscosity (V).

Ry, Bower and Vgwer columns in the table define saturated data as a function of
pressure.

Bopry and V,,dry columns define properties of dry gas.
Also the input for Ry will appear in the Segment Settings—> Reservoir Properties Sheet.

When the Multiple Dew Points option is not activated, NETool assumes that the Ry, Bg
and V; columns in the table define the actual wet gas PVT data as a function of pressure.
Ry must be increasing up to the dew point and must be constant at higher pressure than
the dew point.

PVT Tables Summary

Oil and Dissolved Gas

[black units] indicate units in METRIC.
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{blue units} indicate FIELD units.
PVT table for oil with dissolved gas with one bubble point:
Table 5: Oil and Gas Dissolved

P Rs Bo Vo Bg Vg
Pressure [Bar] | Solution Oil  formation Oil Gas Gas
{PSI} Gas/Oil Ratio volume  factor viscosity formation viscosity
Must be increasing [Sm3/Sm3] [m3/Sm3] [cP] volume factor [cP]
down the column {SCF/STB} {RB/STB} {cP} [Rm3/Sm3] |{cP}
{RCF/SCF}

Oil above bubble point with constant Dissolved Gas

The simplest possible black oil PVT table is for undersaturated oil produced above
bubble point. You get this configuration if you uncheck Gas but keep Oil under Global
Settings—> General> Phase Mode.

Table 6: Oil and Bubble Point With Constant Dissolved Gas

P Bo Vo

Pressure [Bar] Oil formation volume Oil viscosity
{PSI} factor [cP]

Must be increasing [m3/Sm3] {cP}

down the column {RB/STB}

This mode requires that you enter Bubble Point and Dissolved Gas (constant Rg value) in
the inputs below the table.

Oil and Wet Gas

In case vaporized condensate is activated an additional column — Ry (highlighted below)
—1is added to the PVT table:

Table 7: Oil and Wet Gas
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P Rs Bo Vo Rv Bg Vg
Pressure | Solution |Oil formation Oil Vaporized Gas Gas
[Bar] Gas/Oil volume factor |viscosity Condensate/Gas formation viscosity
{PSI} Ratio [m3/Sm3] [cP] Ratio volume [cP]
Must  be [Sm3/Sm3] {RB/STB} {cP} [Sm3/Sm3] factor {cP}
increasing | {SCF/STB} {STB/MMSCEF} [Rm3/Sm3]

down the {RCF/SCF}

column

Dry Gas

When modeling dry gas this PVT table is presented:
Table 8: Modeling Dry Gas

P Bg Ve

Pressure [Bar] Gas formation Gas viscosity
{PSI} volume factor [cP]

Must be increasing [Rm3/Sm3] {cP}

down the column {RCF/SCF}

Wet Gas with Multiple Dew Points

Modeling vaporized condensate with multiple dew points PVT table is presented
(Vaporized condensate + Wet gas PVT with multiple dew points turned ON):
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Table 9: Vaporized Condensate with Multiple Dew Points

P Rs Bo Vo
Solution | Oil Oil

Pressure | Gas/Oil formatio | viscosi

[Bar] Ratio n volume | ty

{PSI} [Sm3/Sm | factor [cP]

Must be | 3] [m3/Sm3 | {cP}

increasi | {SCF/ST | ]

ng down | B} {RB/ST

the B}

column

Rv Bg, wet
Vaporized Wet gas
Condensate/ formation
Gas Ratio | volume
[Sm3/Sm3] factor
{STB/MMSC | [Rm3/Sm
F} 3]
{RCF/SC
F}

Bg, dry
Dry gas
formation
volume
factor
[Rm3/Sm
3]
{RCF/SC
F}

Vg,
wet

Wet
gas
viscosi
ty

[cP]
{cP}

Vg,
dry
Dry
gas
viscosi
ty

[cP]
{cP}

Oil with Multiple Bubble Points

Modeling oil with multiple bubble points gives this PVT table (Oil PVT with multiple
bubble points). Undersaturated oil properties (B, and viscosity) are calculated by NETool
by the use of oil compressibility and viscosibility.

Table 10: Oil with Multiple Bubble Points

P

Pressure
[Bar]
{PSI}
Must  be
increasing
down the
column

Rs

Solution
Gas/Oil
Ratio
[Sm3/Sm3]
{SCF/STB}

Bo, sat

Saturated
oil
formation
volume
factor

(at  bubble
point)

[Rm3/Sm3]
{RCF/SCF}

Co, u-sat
Under-
saturated  oil
compressibility
(above bubble
point) [1/bar]
{1/PSI}

Vo, sat

Saturated
oil
viscosity
(at
bubble
point)
[cP]

{cP}

CVo, u-sat

Under-
saturated

oil
viscosibility
(above
bubble
point)
[1/bar]
{1/PSI}

Bg Vg

Gas Gas
formation viscosity
volume [cP]
factor {cP}
[Rm3/Sm3]

{RCF/SCF}

Oil and Wet Gas with Multiple Bubble Points and Multiple Dew Points
Depending on the PVT options chosen, oil PVT table may have between six and eleven

columns.

Vaporized Condensate

Qil PNT with Multiple Bubble Points

Wet Gas PVT with Multiple Dew Points

P Rs Bo,sat | Co,u-sat | Vo,sat | Cvo,u-sat Rv Bog,wet Bo,dry | Vog,wet Vo,dry
PS | [2CF/ST.| [RE/STE] [/PS] [cF] (1P | [STEM. | [RCFE. | [RCFE. | [cP] [cP]

14.8037.../0.0 1.0 1.72368.. (2.6 1.37895...|0.0 1.0 1.0 0.01 0.0
217586 449166 (1.3 1.72368..]1.0 1.378945. . 17.8108 |0.00BG 0.0ovo oo ooy
4351.13...|898.332 16 1.72368... (0.6 1.37895. |35 6216 |0.0033 0.0034 0.026 0.024
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Figure 26. PVT Layout

Figure 21 shows PVT table layout with all possible columns (multiple bubble and dew
points).

Water PVT Properties

Water PVT Properties are entered in the Fluid Properties Menu=> PVT = Water PVT
data tab. NETool requires:

pw at stock tank conditions

Pref

Bw (Pref)

Hw (Pref)

Cw

Water viscosibility

NETool provides reasonable default values for these parameters.

Eclipse PVTW keyword supplies water properties when From PVT data in Eclipse
format is chosen in the PVT data from dropdown menu.

Eclipse PVT Format

PVT data in Eclipse format may be entered into PVT text area as an alternative to
NETool PVT table input.

NETool will accept Eclipse PVT data in either oilfield units or metric units. The units of
the PVT file are designated by a keyword at the top of the file. Two unit sets are
supported by NETool defined by the keywords METRIC or FIELD. Please note that
Eclipse FIELD units are slightly different from NETool FIELD units

Following Eclipse PVT keywords are recognized by Netool:

Units system: METRIC or FIELD.

The units keyword must be at the top of the file — it must be the first keyword.
Densities at stock tank conditions: DENSITY.

This keyword must always be entered.

Oil properties:

Live oil: PVTO or PVCO

Dead oil: PVDO or PYCDO

Exactly one of these three keywords must be entered if oil phase is present.
Gas properties:

Dry gas: PVDG

Wet gas: PVTG

Exactly one of these two keywords must be entered if gas phase is present.
Water properties: PVTW.
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This keyword must be entered if water phase is present.

RSCONST keyword is recognized in phase modes with no free gas (1-phase oil or 2-
phase oil+water).

Units used by Eclipse are as follows:

Quantity METRIC unit||[FIELD unit

P ||Pressure [Bar] [PSI]

Rs |Solution Gas/Oil Ratio [Sm?*/Sm?] [MSCF/STB]
Rv |Vaporized Condensate/Gas Ratio [Sm?*/Sm?] [STB/MSCF] "
B, |/Oil Formation Volume Factor [Rm*/Sm?®] |[RB/STB]

B, ||Gas Formation Volume Factor [Rm¥Sm?]  |[RB/MSCF]"
B,, ||Water Formation Volume Factor [Rm3/Sm?®] |[RB/STB]

V, y||Viscosity (oil, gas or water) [Cp] [Cp]

C ||Compressibility (oil, water) [1/Bar] [1/PSI]

CV |“Viscosibility” (oil, water) [1/Bar] [1/PSI]

0 ggsesri)ty at Stock Tank Conditions (oil, gas and ke/m?] (1b/e])

D Different from NETool FIELD unit !

The option PVTNUM from will only appear when PVT data is supplied in Eclipse
format. The Eclipse PVT format allows for multiple PVT regions and the PVTNUM
assigns the correct PVT dataset to the region.

Relative Permeability

Relative permeability is part of the Mobility term used in reservoir flow equations.

Relative permeability is determined as a function of fluid saturations, the functions can be
either curves and/or correlations.

The RelPerm data from dropdown menu selects the option to be used when determining
relative permeability.

Five options are available:

From Relperm table — presents relative permeabilities in tables. The number of tables and
table types are defined by the Two-phase Oil Relperms dropdown menu.

From Wyllie’s CS, OL correlation - Wyllie's correlations for cemented sandstone, oolitic
limestone is used. NETool Technical Manual provides more details.
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From Wyllie’s US, WS correlation — Wyllie's correlations for unconsolidated sand, well
sorted is used. NETool Technical manual provides more details.

From Eclipse INIT file — window shows a text area with the relative permeability table(s)
extracted from the Eclipse simulation model, if such data is available in the INIT file.
The data is presented in Eclipse PVT format. The content is not open for edit.

From Relperm data in Eclipse format — has the same look as the option above with the
difference that the text area is by editable and by default empty. User can also copy text
from the content in the option From Eclipse INIT file for purpose of further editing.

Relative Permeability curves can be produced by Fluid Properties=> View-> Visualize
PVT & Relperms for inspection. The same plots will also be produced by NETool in the
output plots after a simulation.

]
File Edit View
RelPerms [ Lift |
RelPerm data from: |Fr0m RelPerm Table | V|
Two-phase Qil Relperms |Tab|u|ated against So |V|
0il Relperm Gas Relperm Water Relperm
So Krog Krow Sy Kry Sw Krw
0.0 0.0 0.0 0.0 0.0 0.25 0.0
0.245 [0 0.0 0.5 0o 0.2 n.o
0.3 n.a 1.0e-4 0.4 001814 0.35 0.004
0.35 n0.00s42 0.0016 014 0.0813 0.4 0.0134
0.4 0.02094 0.0081 0.2 0.09424 0.45 0.03z
0.45 0.04527 0.0256 0.25 014508 0.5 0.0624
0.5 0.08825 0.0625 0.3 0.20276 0.55 0108
0.54 014504 01296 0.35 0.26654 0.6 01714
0.6 026933 0.2401 0.4 0.33588 0.65 0.256
0.65 043376 0.4096 0.45 041036 0.7 0.3645
07 067018 0.6561 0.5 048966 0.75 0.5
0.74 1.0 1.0 0.75 0.95 1.0 1.0
Oil relative permeability model |Ec|ipse default model |V|

Figure 27. Relative Permeability Input Screen

Gas and Water Relative Permeability

Gas and water relative permeability are calculated in a straight forward manner as a
function of gas and water saturation from the values entered in the Relative Permeability
Table:

kre = F(Sg)
kew = F(Sw)

Oil Relative Permeability

Four methods of calculating three-phase oil relative permeability k,, are supported.
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The selected model is determined by the Oil relative permeability model dropdown menu
at the bottom of the Relative Permeability window.

Details of the four models are described in NETool Technical Manual:
Eclipse default model

Stone’s 1* model

Stone’s 1% model modified by Fayers and Matthews

Stone’s 2™ model modified by Geoquest (Eclipse)

Relative permeability Eclipse Format

This section contains the description when using Relative Permeability in Eclipse format.

If several saturation regions exist in the reservoir, relative permeability files may contain
multiple tables, one for each region. NETool will use relative permeability tables from
the well segments corresponding reservoir regions. The table number to use is determined
by Reservoir&Well>Reservoir Data—>Sat. Region (the field is visible only if
SATNUM keyword is present in Eclipse INIT file).

Following combinations of Eclipse keywords are supported:
Netool 3-phase mode (oil+gas+water):

SWOF+SGOF

SWOF+SLGOF

SOF3+SGFN+SWFEN

SOF3+SGWFN

Netool 2-phase oil+gas mode:

SGOF

SLGOF

SOF2+SGFN

SOF3+SGFN (the k;ow column of SOF3 is ignored)
Netool 2-phase oil+water mode:

SWOF

SOF2+SWFN

SOF3+SWEN (the kyoe column of SOF3 is ignored)
Netool 2-phase gas+water mode:

SGOF+SWOF (the ko and kyow columns are ignored)
SGFN+SWFN

SGWFN

End-point scaling

The end-point scaling allows the user to redefine values for the connate, critical and
maximum saturations in the relative permeability table. The table is linearly scaled to
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preserve relative permeabilities at saturation end-points. In addition it is possible to
redefine values of relative permeability at maximum phase saturations (“vertical
scaling”).

This is often used for modeling reservoirs with an initial depth variation of either the
connate or critical saturations.

The implementation is consistent with the one in the Eclipse simulator with the following
omissions:

Only two-point scaling is supported — alternative three-point scaling as defined by the
SCALERCS keyword is not supported.

Connate gas saturation (SGL keyword) is not supported.

Functionality provided by KRWR, KRGR, KRORW, KRORG keywords is not
supported.

For each end point input the following options are available:

No scaling (from relperm table) — do not scale this end point — assume that value of
this end point defined by the relative permeability table is correct for this well segment.

From Nearest Blocks — the value of this end-point will be extracted from the reservoir
gird from the gridblock(s) the well passes through. This option is hidden unless the data
is actually available in the reservoir grid files.

Manual — enter the value of this end-point.
End-point scaling is by default not activated, i.e. No scaling (from relperm table)

10 end-points parameters are recognized as shown in Table 11.

Table 11: End-point Scaling Labels Used in NETool and Eclipse

NETool Swco | Swer Sw_max Sger Sg max Sorw Sorg Krw _max | Krg max Kro_max
label

Eclipse SWL | SWCR | SWU SGCR | SGU SOWCR | SOGCR | KRW KRG KRO
keyword

End-point Scaling by Manual Entry

End-points can be defined manually in Mobilities = Relative Permeabilities >
Saturations folders on the Segment settings/Completion Menu. End-point scaling is not
activated by default (option Unscaled).

End-point Scaling using End-Points imported from Eclipse Model

When any of the end-points are present in the Eclipse .INIT file the following appear in
the NETool user interface:

The selector Reservoir Data in the Reservoir & Well Menu will contain the available
end-point keywords. The end-point values can then be displayed in the grid.
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The Mobilities Relative PerSaturations folder in the Segment settings/Completion Menu
will show three additional folders for specification of end points for oil, gas and water.

Ij Fesermir Parameters
[ Transmissihility
] Permeabilities
7 [ Mabilities
9 [ Relative Permeahkilities
9 [ Saturations
3 End-Paints - il
3 End-Paints - Gas
|j|End-F'uint5 - WWater
2 [ Mohilities
7 [[J Relative Permeakilities
7 [ Saturations
3 End-FPaints - il
] End-Paints - Gas
I [End-Paints - water|

Figure 28. Reservoir Parameters and Mobilities

VFP (Vertical Flow Profile) - Lift Curves

The VFP (Vertical Flow Profile) tables contain information to calculate the relationship
between tubing head and bottom hole pressures as a function of rate, water fraction, gas
fraction and/or artificial lift, based on fluid flow performance in the tubing. This
information is used by NETool to “convert” the tubing head pressure to bottom hole
pressure or vice-versa, depending on the simulation Target and Well Type specified in
the Global Settings=> General input screen.

VFP tables are always used and required as input when the Target is set to Tubing head
Pressure on the Global Settings-> General input screen.

When Target is set to

Bottom Hole Pressure

One of the Flow rates (Reservoir, Liquid, Oil, Water or Gas)
None, Make IPR

The VFP information is not required as input.

However if the Calculate THP checkbox is ticked on Global Settings—> General,
NETool will then use VFP tables to calculate Tubing Head Pressure corresponding to the

Bottom Hole Pressure, and display the Tubing Head Pressure in the Results Summary
Table.

Table 12: Tube Heading Pressure
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Summary Tahle
© D E F G H | J K L Tl
Phase mode | Oil rate Gasrate |Water rate GOR WCUT LGR Qres. total BHP THP Gas Lift Rate
Three phase | 3662 39716 | 1.67522744 0 442181871 0 000226151289 |9216 38773 | 268.8953151 | 82 24772449 I]
B3 | MMSm3id] | [Sm3d | [Bm3rsm3) [%] [Bm3iSm3] [Rm3rd] [Ban] [Ban [MMSrn3id]

Also, for some of the Targets an additional THP vs BHP plot will be generated if the

Calculate THP is ticked.

VFP table format

NETool supports VFP tables (Lift curves) in Eclipse format. Other software applications
are designed for calculating tubing flow performance and generate such lift curves.
Among them is e.g. Prosper which can generate lift curves and then export them in

Eclipse format.

When the well is a production well a production VFP table (VFPPROD keyword) is
needed; when the well is an injection well, an injection VFP table (VFPINJ keyword) is
needed. In other words the VFP table must match the well type specified on the General

tab of the Global Settings Menu.

Artificial Gas Lift option is supported by NETool and is controlled by the Gas Lift Rate
input field on the Global Settings—=> General screen.

Following keywords are currently supported:

VFPPROD keyword:

FLO — flowrate variable
OIL — oil rate

LIQ — liquid rate

GAS — gas rate

WEFR - water fraction variable
WOR — water oil ratio

WCT — water cut

WGR — water gas ratio

GFR - gas fraction variable
GOR — gas oil ratio

GLR — gas liquid ratio

OGR — oil gas ratio

THP — tubing head pressure
ALQ — artificial lift quantity
GRAT — gas lift rate
VFPINJ keyword:
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FLO — flowrate variable
OIL — oil rate

WAT — water rate

GAS — gas rate

THP — tubing head pressure

VFP Table Units

Units system of the VFP data is designated by a keyword at the top of the file. The
keywords METRIC or FIELD are accepted. This keyword MUST appear at the top of
the file — you may need to manually add this keyword.

The Eclipse option to specify the units in item 8 (VFPPROD) of record #1 of Table 13 is
supported and takes precedence over the keyword unit specification at the top of the file.

Units used by Eclipse are as follows:
Table 13: Units Used by Eclipse

Mnemonic Quantity METRIC unit|[FIELD unit

BHP, THP Pressure [Bar] [PSI]

FLO-OIL,

FLO-LIQ, Liquid Rate [Sm?/d] [STB/d]

FLO-WAT

ALQ-GRAT, \ (different  from
FLO-GAS Gas Rate [Sm?*/d] [MSCEF/d] I;Irﬁg)o()l FIELD
WFR-WOR, Liquid/Liquid  ratio 3 s

WFR-WCT (dimensionless) [Sm?/Sme] - |[STB/STB]

WFR-WGR, L . , , (different from
GFR-OGR Liquid/Gas Ratio [Sm*/Sm?*]  |[[STB/MSCF] EIrEtT!)ool FIELD
GFR-GOR, o . , , (different from
GFR-GLR Gas/Liquid Ratio [Sm?/Sm?] [MSCF/STB]|[NETool  FIELD

unit!)

Table 14: VFP Example

VFPPROD

------------------------- Basic data, record 1 --

1 7.000E-03 'LIQ" 'WCT' 'GOR" 'THP''" 'FIELD' 'BHP' /
------------------------ 5 flow values, record 2
1.000E+01 3.000E+02 7.000E+02 1.000E+03 2.000E+03 /
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2.0000E+02 1.000E+03 /
------------------------- 1 WER value, record 4 -

0.0/

------------------------------- 3 GFR values--------=m-smmmmmom oo

1.000E+00 2.000E+00 4.000E+00 /

-------------------------------- 1 ALQ value-------===-mmmmmmm e

0.0/

-------------------- Record 7 to NTHP*NWFR*NGFR*NALQ-+6----------------znmneno-

1111 1.93199E+03 1.6585E+03 6.77031E+02 7.15261E+02 8.62436E+02/--record 7
2111 27366E+03 2.73303E+03 2.7508E+03 2.77323E+03 2.90209E+03 /-- record 8
1121 1.7747E+03 4.33303E+03 5.3808E+02 6.30323E+02 9.3909E+02 /-- record 9
2121 25366E+03 2.38303E+03 2.3608E+03 2.26523E+03 2.28809E+03/ --record 10
1131 1.6477E+03 4.41903E+02 6.9528E+02 8.81623E+02 9.3909E+02 /record 11
2 1 3 1 2.466E+03 1.78303E+03 1.808E+03 1.85153E+03 2.04484E+03 / last record
(2%1*3*1 +6=12)
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Segment Settings/Completion Menu

The Segment Settings/Completion menu (see Figure 29. Segment Settings and
Completion sheet) is used to specify and configure completions, completion components,
reservoir parameters of pressure, permeability and fluid components, skin, and some
other parameters for each segment along the well.

Some of the parameters can also utilize the capability to import the values from text
based log data.

This screen is accessed by clicking on the Segment Settings/Completion sheet at the
bottom of the screen in main NETool window.

Eir E1 W nkx HHp
& wimoea: | Nansoa )] | el Sattings || Fhuid Cripca1is || Rk |
Seanmes Sumngs Complusca

1= Hode & Completian

@ Welzom
¥ & Caainpiina |
(Gl Fett camentedimer v T"Fﬂm 1 269 r";"“" Casingiinee {Band Contiol | Infiaw Canirol I'Bhnger | Tulng | Lefersl Comedian
| * I Sec vl [ [T e EELET [= E [Farker = [Teen -
ik Form atiareGraasl in Amnutue | T porg 02 =L B | [Blankpie I [Tpen
* la sraen 3 [Emans LD [= [ [Elenk o [ | Bgen
@ Wrs-wrapoed Soreen L& BIEIAR |maa A ] |EtankniEe ] |open
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Figure 29. Segment Settings and Completion sheet

The user interface has the following features:

Editable measure depth — both top and bottom measured depth can be edited for each
segment. Simply click on the appropriate segment and edit the depth in the window at the
top of the screen.

Notes

e Top depth of top segment cannot be changed from this screen — use Heel MD in the
Trajectory mode on the Reservoir&Well screen.

e To remove or add segments, you must use Well Segments sheet window on the right.
Bottom Depth cannot be changed beyond the end of the well path.
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Smart entries — some of the input areas are smart entries. Smart entry items allow both a
choice and a numerical value in the same input area. With smart entries, the choice can be
made either by right clicking the input box or in the input line at the top of the screen.
Figure 30 shows the smart entry for Reservoir Pressure.

Reservoir Pressure value: |Manual w7 | |2EHZI.IZI | bar
# | MD [m] | Reservoir Pressure .| Permeability | Kh [D] | Kyikh
1 0.0-1.0 - - - -

2 1.0-201.0 2800 Manual 0.1 0.01
3 |301.0-300.0 280.0| Reseroirpressure 0.1 0.01
4 300.0-401.0 260.0 % Manual 1 - 0.01
& 401.0-500.0 280.0 0.1 0.01
B |500.0-801.0 zan.o| 2 Fram nearest hlocks 0.1 0.01
7 901.0-300.75464 280.0| @ Close me 0.1 0.01
8 900.75464-1001.0 2800 AT, 0.1 0.01
9 1001.0-1124.14190 280.0 Manual: 0.1 0.01

Figure 30. Smart Entry for Reservoir Pressure

Highlighting multiple input areas — multiple entries in a single column can be
highlighted simultaneously. To highlight sequential entries click on the entry at one end,
hold down shift and click on the entry at the other end of the sequence. Single entries can
be added (or removed from the highlighted group by holding CTRL while clicking on
that entry.

Editing multiple highlighted entries — to edit multiple highlighted entries use the
editing bars at the top of the screen.

Cutting and pasting to and from MS Excel — areas of the table can be highlighted and
copied and pasted to Excel. Values in Excel can also be cut and pasted into the tables on
the Segment Settings/Completion Screen

Graying out/Non-appearance of items — input areas which are not used by NETool is
grayed out (or that screen does not appear).

Completion Specification and Configuration

Completion specification in Netool is broken down into two parts:

1. Chose the completion type
2. Configure the parameters for that specific completion type.

Technical descriptions of the completions used in NETool are included in the NETool
Technical Manual.

The completion is specified by choosing the Hole & Completion folder at the left side of
the Segment Settings/Completion screen. Several columns appear to the right where the
completion type for every layer can be specified.

The completion type is chosen in the columns corresponding to four different layers
either by using the pull down menu at the top of the screen or the popup menu that
appears when right clicking the mouse.

Each completion type has its own specific input section that becomes active as Hole &
Completion subfolders when that completion type is chosen as part of the well.
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Specific Completions Types

This section discusses the input parameters for the specific completions. A more
technical discussion is included in the NETool Technical Manual.

The roughness in the tubing and annulus affects the pressure drop. Formation and Pipe
Roughness are available for each completion layer.

Open Hole Completion

The only information required by NETool for an open hole completion is the Wellbore
diameter and Roughness — no additional sub folder is required or available for the open
hole completion.

Damaged Zone skin or manually entered skin is available for the open hole completion
type and discussed in further detail in the NETool Technical Manual.

ICV device

Inflow Control Valve device is a completion type which has a valve in the middle. That
valve connects annular and tubing spaces. In combination with blank pipes and packers at
each side it is usually used for zone isolation. There are different pressure drop models
and several parameters to control flow through it. This type of completion is described in
more detail in the NETool Technical Manual.

The ICV completion is run with an open annulus and the option for a Collapsed Annulus
is available.

Required input parameters for ICV are:

Tubing ID — inner diameter of the isolation tubing used

Tubing OD — outer diameter of the isolation tubing used

Pressure drop calc. — defines which pressure drop model to use for the valve
Parameters related to each pressure drop model.

Slotted Liner

Slotted Liner is a liner with slots cut to allow flow. This liner type is not cemented. A
Technical Description is included in the NETool Technical Manual.

Required input items for Slotted liner are:
Casing/Liner ID — inner diameter of the slotted liner
Casing/Liner OD — outer diameter of the slotted liner
Slots Density — how many slots per ft (or per meter)
Slot Length — length of the slots

Slot Width — width of the slots

Perforated Cemented Liner

The perforated cemented liner input consists of two parts:
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Description of the liner and perforations, and

Choice of skin model and skin model input parameters — the perforation skin input items
are discussed in the Skin section.

Casing/Liner and Perforation Description

The liner/casing and perforations are configured under the Perf. cemented liner folder
under NETool window = Hole and Completion sheet.

The required input items for describing the Casing/Liner and Perforations are:
Casing/Liner ID — inner diameter of the casing/liner

Casing/Liner OD — outer diameter of the casing/liner

Hole Diameter — Entry diameter of the perforation.

Shot Density — number of shots per foot (or meter)

Length of Perforation — penetration length of the perforation as measured from the outer
diameter of the casing/liner.

The last three parameters may also be edited under skin folder.

ICD Completions

ICDs or Inflow Control Devices are completion components that create pressure drops
between annulus and tubing. These devices are primarily introduced to control the zonal
flow contributions to obtain optimized reservoir performance.

ICDs are often associated with horizontal wells and in wells across multiple zones to
avoid premature water and/or gas breakthrough.

NETool includes the following ICD models:

e ICD - Nozzle ICD — an ICD implementation for ICS’s using nozzles to create the
pressure drop.

e ICD - Tubular ICD — an ICD implementation for ICS’s using parallel tubes,
assuming equal dimensions for each tube to create the pressure drop.

e [ICD - Channel ICD — an ICD implementation for ICS’s using parallel channels,
assuming equal dimensions for each channel to create the pressure drop.

e Halliburton EquiFlow (adjustable) ICD — models provided by Halliburton for
EquiFlow ICD completion.

e Baker Spiral ICD, Troll — a pressure drop model for the Baker Spiral ICD based
on laboratory tests with the Troll fluids. This model is only valid for Troll fluids.
Troll is the largest gas field with a thin oil column located offshore Norway.

e Baker Spiral ICD, General — a general implementation of the Baker Spiral ICD
model valid for a variety of fluids.

e Baker Adjustable ICD — a model for the Baker Adjustable ICD.

e Autonomous ICD — a generic equation for modeling autonomous ICD or valve.

All ICD completion types have annulus and tubing node layers. They can be run with
open annulus or collapsed annulus. The collapsed annulus facility is available under Hole
and Completion to have Collapsed Annulus.

Nozzle ICD
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The Nozzle ICD can be used for any ICD type device. Pressure drop is simulated using a
nozzle calculation. This option is appropriate for example for Reslink ICD’s which use
nozzles to generate the pressure drop.

The required input parameters for the Nozzle ICD are
Tubing OD — OD of the ICD device
Tubing ID — ID of the ICD device

Joint Length — the spacing between the pressure inducing devices. Normally they are
placed one per joint.

ICD Nozzle Diameter

Flow coefficient

Number of parallel Nozzles per joint length - up to 30 individual nozzles
Further discussion of the Nozzle ICD is included the NETool Technical Manual.

Tubular ICD

For the Tubular ICD, pressure drop is simulated using parallel tubes, assuming equal
dimensions for each tube calculation.

The required input parameters for the Tubular ICD are
Tubing OD — OD of the ICD device
Tubing ID — ID of the ICD device

Joint Length — the spacing between the pressure inducing devices. Normally they are
placed one per joint.

Tube diameter

Tube length

Number of parallel tubes per joint

Minor Loss Coefficient

Further discussion of the Tubular ICD is included in the NETool Technical Manual.

Channel ICD

For the Channel ICD, pressure drop is simulated using channels tubes, assuming equal
dimensions for each channel.

The required input parameters for the Channel ICD are
Tubing OD — OD of the ICD device
Tubing ID — ID of the ICD device

Joint Length — the spacing between the pressure inducing devices. Normally they are
placed one per joint.

Channel hydraulic diameter from (manual or calculated)
Channel hydraulic diameter

Channel cross-section
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Channel length
Number of parallel channels per joint

Minor Loss Coefficient
Further discussion of the Channel ICD is included the NETool Technical Manual.

Halliburton EquiFlow ICD

This model is based on nozzle and frictional pressure drop models to calculate pressure
loss through flow tubes within pressure drop chamber of the EquiFlow ICD. The main
input parameters are:

Tubing OD — OD of the ICD device
Tubing ID — ID of the ICD device

Joint Length — the spacing between the pressure inducing devices. Normally they are
placed one per joint.

EquiFlow ICD type- allows the user to select one of the predefined settings or manually
specify the three tube design parameters (length, diameter, quantity).

The predefined settings notation, like 20 x 100, means the pressure drop for a certain rate
across the EquiFlow ICD. The pressure drop is given in psi and the rate in bbl/d for a
nominal fluid with viscosity 1 cp and specific gravity of 1. The example 20 x 100 means
20 psi pressure drop at a 100 bbl/d rate.

The manual option facilitates flexible configuration of the pressure drop chamber in the
EquiFlow ICD. The user can specify length and diameter of the tubes, as well as the
number of tubes in parallel.

Tube length (customized) - Length of the tube in the EquiFlow ICD's pressure drop
chamber

Tube Diameter(customized) - Diameter of the tube in the EquiFlow ICD's pressure drop
chamber

Number of tubes(customized) - Number of parallel tubes in the EquiFlow ICD's pressure
drop chamber

Halliburton EquiFlow Adjustable ICD. The pressure drop is created by six tubes of
different diameters. The completion has a threaded removable sleeve to allow access to
the flow tubes. The flow profile is changed by closing or opening a pre-determined set of
tubes and is carried out at the surface.

Baker Spiral ICD, Troll

The pressure drop correlation for the Baker Spiral ICD, Troll is based on tests performed
with Troll (offshore Norway) reservoir fluids and this specific item of equipment. The
results of this model do not use the PVT data of the fluids supplied to NETool. This
model is only valid for the Troll field.

5000.0.1.0 Page 77 of 113 2012



Landmark NEToo0l™ User Guide

Please contact Baker Oil Tools for further information.
The required input parameters for this model are:
Tubing OD — OD of the ICD device

Tubing ID — ID of the ICD device

e Spiral ICD Type — the input choices are for 5 settings of this device with the number
representing the pressure drop in bar at nominal rate with nominal fluid, which are
associated with the commonly used settings for Baker Spiral ICD.

Baker Spiral ICD, General

The Baker Spiral ICD, General is a general implementation of the Baker Spiral ICD —
unlike the Baker Spiral ICD, Troll, this completion type is affected by the PVT properties
of the fluids.

Please contact Baker for further information.

The required input parameters for this model are:
Tubing OD — OD of the ICD device
Tubing ID — ID of the ICD device

Spiral ICD Type — This is a smart input item, it can be set either to one of the predefined
settings of the ICD or manually using the Coefficients A and B. The 5 numeric input
choices are settings of this device with the number representing the pressure drop in bar
at nominal rate with nominal fluid, which are associated with the commonly used settings
for Baker Spiral ICD

Manual definition — coefficients A and B are used to determine the pressure drop. This is
an advanced option and would normally only be used for the detailed design and after
conversations with the vendor.

Baker Adjustable ICD
An adjustable ICD from Baker which can have 2 to 6 ports open.

The required input parameters for this model are:

Tubing ID — ID of the ICD device

Tubing OD — OD of the ICD device

e Adjustable ICD Type — Number of open ports on the ICD.

Autonomous ICD.

This model allows simulating inflow control devices that use “autonomous” concepts.
These include Statoil’s Rate Controlled Production (RCP) and Halliburton’s Equiflow
AICD. These devices are characterized by a high dependency of pressure drop on flow
rate: dP ~ ¢" where n can be in a range [3;5].
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Screens.

There are three types of screens available: Generic, Perforated pipe and wire-wrapped.

Screens usually create an insignificant pressure drop between annulus and tubing. All
types can have sand pack or filter cake.

Generic.

This type of screen represents a completion with a very large flow area and therefore zero
pressure drop across the completion. There are no input parameters.

Perforated pipe.

Represents a pipe with round holes. Input parameters are “Perforation diameter” and
“Perforation density”. Orifice equation is used to calculate pressure drop.

Wire-Wrapped Screens

This completion uses both the annulus and tubing node layers, hence the option for
Collapsed Annulus is available.

The wire-wrapped screens completion includes the option to simulate a filter cake built
up on the outside of the screen — this option is available under an additional folder Filter
cake/Annulus fill.

Wire-wrapped Screen input data
Figure 31 illustrates the various components in wire-wrapped screens.
The following are the required input items for wire-wrapped screens:

e Screen base pipe ID — Internal Diameter of the Screen Base Pipe. The same as the ID
of the screen.

e Screen base pipe OD — DO NOT USE SCREEN OD HERE. Screen OD is
calculated by NETool. It is the OD of the screen base pipe that should be entered.
NETool calculates the Screen OD = Screen Base Pipe Outer Diameter + 2*Height of
Flow Channel + 2* Wire Thickness

e Perforation diameter — diameter of the perforations in the screen base pipe.
e Joint Length — length of each screen joint.
e Perf. Density- Perforations per length of unit.

e Width of flow Channel — the width of the space radically between the longitudinal
wires of the screen. “w” in the Figure 31.

e Thickness of flow channel walls — width of the longitudinal wires (those first laid on
the base pipe). “s” in Figure 31.

e Height of flow channel — thickness of the longitudinal wires (those first laid on the
base pipe). “d” in Figure 31.

e  Wire Width — width of the outer wires of the screen (those that hold back the sand).
“Wy,” in Figure 31.

e Wire Thickness — thickness of the outer wires of the screen. “h” in Figure 31.

[}

e Spacing between wires — the gap between the outer wires of the screen. “y” in Figure
31.
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Pre-Perforated Base Pipe — tubular
pipe with a holes drilled in it

Inner (Longitudinal) Wire — first on
welded onto the basepipe, runs
along axis of pipe

Outer (Radial) Wire — wound around
the pipe, this is the on that holds
back the gravel
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Figure 31. Wire-wrapped Screens Illustration

Filter Cake/Annulus Fill Input

The wire-wrapped screen model includes an option to model a build up of porous media
(filter cake) on the outside of the screen and the effect of this filter cake on the
productivity of the well.

The filter cake modeling can be used to model gravel packs also — without slip in the
annulus — this modeling is identical to checking the box collapsed annulus on the under
the Hole and Completion folder. For modeling of gravel pack which includes the slip
between gas and fluids please use the gravel pack option.

The following are the input items under Filter cake/Annulus fill:
Sand Pack Thickness — thickness of the filter cake built up on the screens.

If a value of thickness greater than or equal to than annulus thickness is entered, the
annulus is considered filled.

For compatibility with older versions, entering a negative number also simulates the
annulus filled with porous media. In the current version please use collapsed annulus
rather than a negative number.

Sand pack permeability — this is a smart input item. There are two choices under this
item:

Manual — enter the permeability of the sand pack/filter cake here.

Use Sand Properties — permeability is calculated base on the following input parameters:
Sand pack porosity — porosity of the sand pack

Sand particle shape factor — particle shape factor.
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Sand grain diameter — average diameter of the sand grains in the filter cake.

Gravel Pack

The Gravel Pack completion is used to simulate an open hole gravel pack. Wire-wrapped
screens are used to contain a gravel filled annulus against an open hole.

In versions prior to 5000.0.1.0 NETool had “Gravel pack” and “Cased Hole Gravel Pack”
completions. From v5000.0.1.0 they are replaced with “Screen+Formation/Gravel in
Annulus”. To model Gravel pack:

1. Chose desired screen type on “Sand Control” layer.

2. Select “Formation/Gravel in Annulus”

3. For Cased Hole Gravel Pack also select “Perf. Cemented liner” on “Casing/Liner”
layer.

The most common screen to be used with Gravel Pack is Wire-wrapped screen. The
Wire-wrapped screen folder is used to input the wire-wrapped screen portion of the open
hole gravel pack system. For more information on inputting the wire-wrapped screen
information, please see the previous section. Filter cake/annulus fill of the wire-wrapped
screen section is not used for the gravel pack model.

The required inputs for the gravel pack model (as illustrated in Figure 32) in addition to
those under the wire-wrapped screen folder are as follows:

Annular Permeability — Permeability of the Gravel Pack Sand.

Phase slip - may be checked/unchecked

Corey Index — used in the slip (simple two phase relative permeability relationship) for
slip between gas and Liquids as they flow along the well through the gravel. Acceptable
values are equal to or greater than one (1). Two (2) is commonly used.

Phase Slip Correlation — determines to use 2-phase or 3-phase slip model.

Annular Forchheimer beta - for modeling non-Darcy flow effects.

For Cased Hole Gravel Pack under the “Perf. Cemented liner” the following input is
available:

Gravel filled perf. length —this input area allows simulations based on how the perforation
tunnel has been filled with gravel. Appropriate values range from zero — perforation
tunnel completely void to Length of perforations as entered under the Perf. cemented
liner sub-folder.
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Figure 32. Gravel Pack Illustration

Blank Pipe

The blank pipe completion is used when a section of blank pipe is run to isolate the
tubing from the annulus along a section of the well.

For the blank pipe completion type the inner and outer diameter of the blank pipe section
are required as input:

Tubing/Casing ID — inner diameter of the blank pipe
Tubing/Casing OD — outer diameter of the blank pipe

Cemented Blank Pipe

The cemented blank pipe completion type is used when no annulus is present and there is
not any flow from the reservoir. If it is desirable to simulate a portion of the production
tubing, the cemented blank pipe completion type should be used.

The only required input item for cemented blank pipe type completion is the inner
diameter of the casing/liner/tubing.
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For stability of the NETool solver, the top segment in the well is always cemented blank
pipe. If this is not a part of your completion scheme please just make the segment very
short (like 3ft or Im) and it won’t affect your results.

Packer

This is a short device which blocks annular space. In NETool model, it is equivalent to
Cemented Blank Pipe. However, for user convenience it is included as a separate
completion type.

Packer can be sealing — if there’s no leak between the packer and wellbore walls and non-
sealing (there’s a gap fluids can go through). Non-sealing packer is plotted in yellow
instead of red on completion plot.

Inline Choke/Plug

This completion type can restrict or completely block flow within the tubing. It has the
same pressure drop models to choose from as the ICV completion type.

There is also an option to allow for annulus flow around the restriction/plug.

Reservoir Parameters

The Reservoir parameters folder is used to define reservoir properties for calculations of
flow performance between reservoir and wellbore. The modeling is based on PI models.

The flow is calculated per each segment. The basic PI formula is Qphase = Aphase’ T-AP
where A is fluid mobility, T is transmissibility, AP is pressure difference between
reservoir pressure (input) and annulus pressure (calculated by NETool).

The following input columns are available under the top level Reservoir parameters
folder:

Table 15: Top Level Reservoir Parameters Folder

Reservoir Parameters Folder

Column Description
Connected to | Defines if a segment is connected to reservoir. Checked means it
reservoir is connected to reservoir. Unchecked has same effect as zero

permeability or non-perforated liner.

Reservoir Pressure Three input options are available for data input:

Manual. Reservoir pressure values are entered manually here or
imported from a log. The appropriate reservoir pressure when
entered manually is dependent on the settings for the PI model —
for Horizontal wells, with Steady State Model enter Pressure at
the boundary of the reservoir and average reservoir pressure for
the Semi-Steady State model.

From nearest blocks. Reservoir pressure values are taken from
the reservoir grid from the blocks the well passes through.

From grid upscaling — permeability value is averaged from the
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grid data

Rs

Rs, Solution Gas Oil Ratio, is the amount of dissolved gas in oil
at the current reservoir condition.

This input column will only appear if 1) an Eclipse type PVT
table includes the PVTO keyword with multiple Rs values or if
i1) NETool format PVT table is given with multiple bubble points
for oil. Otherwise, the value of Rs is well defined in the PVT
data having a unique pressure relation and this column is not
necessary and is hidden.

Three options are available for data input:
Manual entry of the Rs value.

Saturated. Assumes that the oil is saturated and the Rs is a
function of Reservoir Pressure

From nearest blocks. Rs values are populated from the
gridblock(s) the well passes through. This requires the imported
Eclipse restart file includes Rs values.

Rv

Rv, Vaporized Condensate Ratio, is the amount of condensate
liquid that is vaporized in the gas at the current reservoir
conditions.

This input column will only appear if) an Eclipse type PVT table
includes the PVTG keyword with multiple Rv values or if i) the
NETool format PVT table is given with vaporized condensate
and multiple dew points. Otherwise, the value of Rs is well
defined in the PVT data having a unique pressure relation and
this column is not necessary and is hidden.

Three options are available for data input:
Manual entry of the Rv value.

Saturated. Assumes that the gas is saturated with vaporized oil
and the Rv is a function of Reservoir Pressure

From nearest blocks. Rv values are populated from the
gridblock(s) the well passes through. This requires the imported
Eclipse restart file to include Rv values.

Transmissibility

Transmissibility is a part of the PI modeling.

The transmissibility equation can be described as T = A / (B + S), where S is the skin

value.

Table 16: Transmissibility Subfolder

Transmissibility Subfolder

5000.0.1.0
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Column

Description

Transmissibility

Three options are available for data input:

From PI model. Transmissibility is calculated by NETool based
on upscaled permeabilities, skin and other PI model parameters.

Manual. Transmissibility is entered manually or as a log. NETool
skin model can’t be applied in this case since user entered T must
already include all skin effects.

Manual T A & T B. Same as previous but allows using NETool
skin model. Transmissibility (T) is calculated as follows: T=T A
/(T_B+S)

Transmissibility A

Enter the A factor in the Transmissibility equation in the form:
Transmissibility = A / (B + S)

Transmissibility B

Enter the B factor in the Transmissibility equation in the form:
Transmissibility = A / (B + S)

Transmissibility
multiplier

The transmissibility is multiplied by this value. This capability
has been included to ease history matching and quickly run
sensitivities.

Skin factor also affects the flow from the reservoir (as calculated by the PI model) and
details are discussed in Skin section

PI model

The folder PI model will appear only if the Global Settings->Inflow->Set PI model for
each segment is checked.

Permeabilities

Table 17: Permeabilities Subfolder

Permeabilities Subfolder

Column Description

Kh Horizontal permeability. 3 options are available for data input:
Manual — permeability is entered manually or as a log.
Use grid upscaling — permeability value is upscaled from the grid
data
From nearest blocks — permeability is averaged from the grid
blocks well is passing through

Kv/Kh Ratio of Vertical to Horizontal Permeability used to define the
vertical permeability. 3 input options are available:
Manual — ratio is entered manually or as a log.
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Use grid upscaling — ratio is upscaled from the grid data

From nearest blocks — ratio is averaged from the grid blocks well
is passing through

Bedding Dip East

is the dip of the reservoir in the eastward direction, angle down
from horizontal towards the east. Bedding dip East and Bedding
dip North are used to determine the dip angle of the reservoir such
that the angle of the well relative to the dip angle of the reservoir
can be calculated. The angle of the well relative to the bedding
plane of the reservoir is then used to determine which PI
calculation 1is used (vertical well, deviated well, or horizontal
well).

Bedding Dip North

is the dip of the reservoir in the north direction, angle down from
horizontal towards the east. See more description above.

Upscaling radius

Permeability values of grid blocks inside this radius (measured
from the wellbore) are included in upscaling.

Upscaling MD step

Specifies axial step used in upscaling (dZ in cylindrical coordinate
system)

N angular steps

Specifies number of angular steps used in upscaling (360°/d6 in
cylindrical coordinate system).

About Upscaling:

NETool uses a proprietary anisotropic upscaling technique which access scattered
permeability data from the Eclipse grid and averages it for use in the NETool analytical

PI equations.
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Figure 33. Upscaling of Parameters

Mobility
Phase mobilties control how the fluid properties and fluid-rock interactions affect
production or injection.

Mobilities are used in the basic equation for flow of each phase:

Phase influx = phase mobility x transmissibility x (reservoir pressure —
annulus_pressure).

Qphase = Aphase" T AP

The phase mobility term () is:

phase_mobility = phase relative permeability/phase viscosity.
Aphase = Kr phase/Mphase

Mobilities are used in the basic equation for flow of each phase:

Phase influx = phase mobility X transmissibility x (reservoir pressure —
annulus_pressure).

Qphase = xphase' T-AP.
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Injection Mobility

Netool has the following two methods for determining mobility of the injected fluid in
the formation:

Long Term.

This model assumes injector has been operational for a long time and formation is filled
up with the injected component. Mobility equals to the mobility of the component being
injected:

Gas Injector 'Water Injector

Ae = Tpgdw = Dy
Qg =Ag'T-AP Qy = Ay T-AP

Short Term.

This model assumes injection process is starting and formation has its original fluids in
place — the injected phase has not penetrated the near-wellbore area to any great extent.
The injected fluid is displacing all movable phases according to their calculated mobility.
The effective mobility equals to the sum of mobilities of phase components:

Gas Injector Water Injector
}\‘o:kro/ Mo xg: kro/ Mg 7\/w:kro/ Hw
Qg = (AotAgtAy) T-AP |Qy = (AgtAgthy) T-AP

Skin

NETool includes skin in the PI model. Skin can i) be entered manually or ii) be
automatically determined.

Input parameters for skin calculation:

Table 18: Skin Calculation Parameters

Skin type Description

Additional This is skin in addition to perforation skin, Non-Darcy skin and near well
skin bore damage skin. Additional skin may be entered per segment or be
imported as log.

Perforation | If perforation skin is checked under Skin folder the following parameters
skin may be defined in Perforation subfolder

Perforation Skin Model — this item is used to choose between the two
perforation skin models. This item is not active unless the completion type
is Perforated liner or Cased hole gravel pack. Choices include:

Karakas, Tarig — a model based on SPE 18247 numerical simulations of
vertical well which has been adopted for horizontal and deviated wells.
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Furui, Zhu and Hill — a model developed for horizontal wells; which
considers the effect of perforation orientation in anisotropic media. This
model was published in SPE 77363 and is adapted in NETool for use in
deviated and vertical wells.

The two perforation skin models are discussed in more detail in the
Perforated Liner Section of the NETool Technical Manual.

K/K — Crushed zone permeability / original formation permeability ratio
Radius of crushed zone — », — radius of the zone around the perforation
tunnel where the permeability has been damaged by the perforation
process.

Phasing angle — o — phase angle between successive shots in the
perforation gun. Due to the differences in the methods that were used to
derive the two skin models, they have different ranges of validity with
respect to perforation phase angle
Valid values are:
Karakas, Tariq model: 0, and 45-360 degrees

Furui, Zhu, Hill: 90, 120, 180, 360 (0) degrees

Perforation Orientation — this input value is only used with Furui, Zhu and
Hill Perforation skin Model and is grayed out when the Karakas and Tariq
Perforation Skin Model is chosen. This is the angle of the perforations
from the horizontal plane when considered for a horizontal well.
Commonly high side or low side perforating is used when oriented
perforating, both are designated by an input value of 90.

Shots density — number of perforations per length unit

Length of perforations — length measured from OD of casing/liner

Hole diameter — entry diameter of perforations

The last three parameters may also be edited under Perforated Cemented
Liner and Cased Hole Gravel Pack.

Non-Darcy | If Non-Darcy skin is checked the following options are available:

skin D factor — D is non-Darcy flow coefficient and may be defined as:
Manual — manually entered D factor when known, e.g. from well tests
From Forchheimer beta — the non-Darcy term is calculated from rock
properties — Forcheimer’s pB-factors
Rock Forchheimer beta
Damaged zone Forchheimer beta
Additional details are provided in the NETool Technical Manual.

Near If this parameter is checked the following may be defined:

wellbore K4/K — ratio of damaged zone permeability to native permeability. Used

damage for all automatic skin calculations.

Radius of Damaged Zone — Radius of the damaged zone, measured from
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the center of the Wellbore

A schematic of the damaged zone is included in the section Open Hole in
the NETool Technical Manual. The perforation skin calculation considers
the damaged zone and the perforations penetration into or through the
damaged zone.

The following other input items also affect the calculation of the
perforation skin:

Under the Perf. cemented liner folder: shot density, hole diameter and
perforation length and

Under this Skin folder: K4/K and Radius of Damaged Zone.

As mentioned under the description of the Cased Hole Gravel Pack
completion in the NETool Technical Manual, pressure drop through the
perforation tunnel is not included in the skin as calculated for the PI
equation. Therefore, Gravel filled perf. length under the Cased Hole
Gravel Pack folder does not affect the skin as used in the PI equation and
displayed in the NETool results. The pressure drop through the gravel
filled (or void) perforated tunnel is included in the pressure drop from
annulus to tubing.

Please note that described skin models give approximate estimate for skin
factor and are good only for commonly used parameter values (like
perforation length, density, permeability reduction, etc.). For a rigorous
skin calculation, 3D finite element simulation is required in each case.

The perforation skin models are discussed in more detail in the NETool
Technical Manual.

Discretization

This folder controls spatial discretization of the solver.

No of Intermediate Nodes NETool uses intermediate nodes between the nodes defined
by the user. By default, the number of intermediate nodes is set to 10. In some cases
where a large number of nodes are defined, the number of intermediate nodes can be
reduced to speed up simulation time. In other cases where a very small number of nodes
are defined by the user a larger number of intermediate nodes may be used. Sometimes
convergence for difficult cases can be improved by changing the number of intermediate
nodes. When error messages recommend changing the number of intermediate nodes, the
user should also check the input data, especially consistent PVT data, for self consistency
because NETool cannot solve physically impossible cases.

Spacing of Intermediate Nodes This is an alternative option to define intermediate
nodes. The distance between every two adjacent nodes is specified. The number of
intermediate nodes is calculated as Segment length / Spacing of intermediate nodes

5000.0.1.0 Page 90 of 113 2012




Landmark NEToo0l™ User Guide

rounded upwards to the nearest whole number. The nodes are then evenly distributed in
the relevant segment.

Log Entry Capabilities

NETool allows for easy import of log data for some parameters. The log screens also
allow for interactive manipulation of the parameter values per segment. The screens also
facilitate manipulation of nodes (move, delete, create).

Log data can be pasted into NETool or imported from file as two columns format:
Measured Depth Log Value

These log values are automatically averaged (arithmetic averaging) by NETool for each
individual segment.

The following parameters can utilize log input capabilities:
e Wellbore Diameter — generally taken from the open hole caliper log

e Reservoir Pressure Values — sometimes from logs and other times from another
source and entered as a log for convenience

e Transmissibility — this value would normally be calculated by another software tool
and the log import in the case is a convenience issue.

e Transmissibility A - this value would normally be calculated by another software tool
and the log import in the case is a convenience issue.

e K, (Horizontal Permeability) — usually derived from log data based on field specific
correlations between log data and core tests.

e K,/Kj (ratio of Vertical to Horizontal Permeability) — occasionally field specific
correlations are made, this particular input is more commonly used for convenience

e Skin — usually derived by some external method — included for convenience.
e Mobility — three different options available.

e Oil/Gas/Water Mobility — this would normally be data generated by a reservoir
simulator and the log import functionality provides a convenient method of moving this
data to NETool.

e Oil/Gas/Water Relative permeability — processed saturations derived from downhole
log measurements. In addition relative permeability must be provided in order to calculate
the mobility.

e Oil/Water Flowing Fractions — usually taken from production log data.

To access the log entry features of NETool, the particular input item must be set to
manual (except in the case of wellbore diameter for which there is not the option to
extract from the reservoir grid).
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Figure 34. Kh Screen Prior to Entering the Log Values

To enter the log, click on the Enter log box at the top of the view. This will bring up a
text entry windows.

When the window is initially opened, it will have three lines of text describing the two
data that NETool is expecting and the units for that data.

Log input and units

The units are dependent upon the current units active when the Enter Log button is
pressed. In this case we have ft for measured depth, if your data is in meters for measured
depth, just cancel the window, change the units in NETool to metric and click Edit Log
again. The units will then appear in metric.

You can also locally change the units on this screen and those will affect the units
expected for the log. For example if the units for permeability in your data are mD rather
than D, highlight one of the permeability values and change the units to mD. When the
log window is re-opened, NETool will display the units of permeability as mD and hence
expects input in mD.

The log input window accepts text input. The most common method of generating this
text input is to open the data from its source within your organization in a spreadsheet
(MS Excel for example). Then use Excel to generate to adjacent columns of values. Then
highlight these two columns of values and copy/paste them into the NETool input
window.

After OK is clicked, NETool has “saved the log” in NETool internal units. If the units in
NETool are changed and the Enter Log button is clicked to view or edit the log data, the
log will be presented in the current NETool units, as shown in Figure 35.
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The log will then be displayed on the graph of value (in this case Kj, vs. measured depth).
The values assigned to each segment will be changed to the average log value for each
segment.
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491565 415.650 1.3748
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Figure 35. Kh Screen With Log Values

Interactivity with log data

The log graphic screen offers the following interactive options for working with the log
data such that the averages taken from the log are transferred to NETool in an accurate
manner. An example is illustrated in Figure 35.

Change the value of the average value for segment

User may prefer to adjust the average that NETool calculates, there are two ways of
doing that:

Graphically — to change the average graphically, simply use the mouse to move the
average bar up or down to an appropriate value.

Numerically — The average can also be changed by typing in a new value in the table — in
this case under K,

Move nodes — one can also move the nodes to improve the discretization to better match
the log.

Graphically — The nodes can be moved graphically by using the node indicators on the
graph, for which the graph must be in Edit: Move Nodes mode on the bottom of the
screen.
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Numerically — the nodes can also be moved numerically by typing in a new top measured
depth in the table.

Figure 36 shows the example with the nodes moved to provide discretization that
matches the layering apparent in the log better.

To achieve a re-average of the log after moving the segments, click on enter log and then
OK and the log data imported will be re-averaged.

Add/remove nodes — nodes can be added or removed graphically by changing the Edit
menu below the plot to Add/remove nodes. Nodes are added by clicking on the node
line. Nodes are deleted by right clicking on a node and selecting delete.

In the example above, the default number of nodes was insufficient for the layering of the
reservoir. Additional nodes were added at the layer boundaries to create the final
discretization.

It should be noted that moving the nodes for the log moves the nodes in ALL of NETool
and any completion components that have been assigned are also moved. It is
recommended to do work with the node placement in the log import prior to entering the
completion.

Zooming — one can zoom in on the log graphics screen by changing the zoom level on the
bottom right of the graph screen.
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Figure 36. Interactive Work With Log Data
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Running NETool Simulations

Before running a simulation, make sure your well case contains consistent and physically
correct data.

Select the Run button to launch NETool simulations. Normally the simulations only take
a few seconds unless heavy upscaling is taking place.

Results are reported in the Plots Viewer.

Calculations can be interrupted by clicking the STOP button. Please note that
calculations may not be interrupted immediately, you may need to wait for several
seconds before NETool can accept user input again.

While NETool is running, some text will be displayed in the black MS-DOS command
window.

If you have any difficulties with NETool simulations, the text reported in this window
can also be helpful.

Warnings and errors may also appear in the Plots Viewer.
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Simulation Results

The NETool simulation results presented in Plots Viewer window (as illustrated in
Figure 37), are both graphically illustrated as plots and as a table of numeric values that
can be easily cut and pasted into Excel for additional calculations/plotting. The numeric
values are included on the Details screen in NETool.

The data is organized in a tree view.
Meaning of the folders:
[ - Folder. Results from a single simulation are organized in a folder.

il - Group of plots in a single screen. If you wish to see plots individually, click on the
handle & to expand.

ut - A single plot
- Tabulated data, for example Details screen.
n - Text, for example, Warnings or Nick name to run.
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Figure 37. Simulation Results Display
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Qutput Units

In general, it is best to run NETool with your preferred unit system (FIELD or METRIC).
The plots on the output can be viewed in either units system by choosing the units system
on the output menus. However, the Outcome and Details pages are available ONLY IN
THE UNIT DEFINED FOR THE SIMULATION.

Saving, Copying and Printing Plots

To save all results use
File>Save As
This will save all the data as a *.ntlplot file

To save a part of the output, for example to save an output from a particular simulation
run or to save an individual plot, click on an appropriate item in the “tree view” on the
left hand side of the screen and then choose

File=>Save Selection As

This will save a *.ntlplot file with only the data selected. Use Ctrl key to combine
several items in the selection.

* ntlplot files can be opened later:

e - with a standalone NETool Plots Viewer program included in the package
e - from any running output window by using File=>Open.

e Exporting data:

The plots (u, id) can also be exported as image files by selecting them in the Tree View
and using

File-> Export Plot as Image File ...
Tables (") can be exported in HTML format with
File> Export Table as HTML File ...

Copying to the clipboard:

e Use Edit=>Copy or Ctrl+C to copy plots that you see. Paste them into Excel, Word
or other applications. Plots will be pasted as pictures at the size as you see them.

e Any portions or the whole table can be selected with the mouse and copied and pasted
into Excel (or other programs where they will normally appear as an html table). To select
the entire table type Ctrl+A.

e [f you wish to have table columns and rows transposed, for convenience (or because
the data is too wide to fit in the available number of columns in Excel, use Ctrl+T to
transpose columns and rows. A repeat of Ctrl+T will toggle the transposition back.

Print plots with File=> & Print.
Table 20:Overview of NETool Results
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e Parameter

e Description

e Fluid Phase

e Flux between annulus and tubing (across
ompletion)

e  Summary e Main results for the whole well of oil, gas and | @
able/plot water rates, GOR (Gas Oil Ratio), Wcut (Water
Cut), BHP (Flowing Bottom Hole Pressure
e Pressures e Tubing pressures, annulus pressures, reservoir | @
pressures, pressure drop across completion
e Rates— e Rates in Stock Tank conditions: e Oil, gas,
ST conditions e Annulus flow rate vater,  condensate
. if present) rate,
e Tubing flow rate 5OR, LGR and
e Flux between well and reservoir vater cut

e Rates—
ST conditions

e Rates in Downhole conditions:

e Flow rates and volume fractions in tubing and
innulus

e Fluxes and volume fractions between well and
eservoir and between annulus and tubing (across
rompletion).

e Downhole
ate,

e oil, gas, water
ractions.

e Velocities e Velocities in tubing, annulus and ICD’s °
e Permeability e Graph of horizontal permeability Kh, vertical | ®
rermeability Kv, Kv/Kh ratio and isotropic
permeability (V(Kv*Kh)) along the well path as
were used in the calculations (including upscaling,
og averaging, or multiplier that was applied in the
nput)
e Saturations e Saturations (or Flowing Fractions depending | e Oil, gas,
n the basis of the simulation) water
e Relative e Relative Permeability of oil, gas and water | ® Oil, gas,
Permeability ralculated based in input saturations and rel. perm vater
able.
e  Mobility e Mobility of oil, gas and water e Oil, gas,
water
e  Transmissibility e Transmissibility; A and B transmissibility | @
ractors.
e Skin ° °
e Productivity e Productivity for oil, gas, water in stock tank | e Oil, gas,
ronditions along the well water
e [PR/Target e [PR/Target and IPR/Target Table — Inflow | e Oil, gas,
Performance Relationship — Flow rate vs. bottom ater
nole pressure as typical of IPR curve. IPR is shown
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when Global Settings=> Target is other than Flowing
BH Pressure.

e Details e A table with numeric values used in or | e
esulting from the calculations

e PVT data e Plots for all parameters present in PVT table, | @ Oil, gas,
ncluding multiple bubble/dew point tables. water

e RelPerm data e Plots for all variables in relative permeability | ®  Oil, gas,
able. If multiple tables are used (SATNUM pater

ceyword is present in Eclipse model) separate plot
for each table used by NETool will be displayed

e FExternal data

Comparing Results from Different Runs

NETool has capabilities to make comparison plots where results are combined from
different runs. This could be done by pressing “Compare Runs” button in the results

window. The button becomes enabled if more than one simulation has been made.

File Edit Units

Ra@mae

“« B

o= [ 2000 flowrate
9 [ 2500 flowrate

Summary Table 50
o [l Summary Plot :
2 [l Pressures A |48

Figure 38. “Compare Runs” button

aw [Smd

This button activates “Compare plots dialogue” shown on Figure 39 below.

5000.0.1.0

Page 99 of 113

2012




Landmark

[1] Give a name to this comparison

|Dnmparisnn#1

[2] Select Two or More Runs to Compare

Hickname:

homogeniousilift_testirun#s |2EIDD flowrate

homogeniousilift_testirun#é |EEDD flowrate

[3] Choose Plots to Compare -
Summary Plot

Pressures

[ ] Tubing flow

Into Well

[ ] Tubing Flow (DH Conditions)
[ ] Into Well {DH Conditions)

[ ] Velocities
Mobility

[ ] Permeability

NEToo0l™ User Guide

| Compare || Cancel |

Figure 39. Compare plots dialogue.

User is supposed to:

1. Chose a name for the comparison results. This name will help to keep track of
results if multiple compares has been made.

2. Select the runs he wants to compare and give them short nicknames. These
nicknames will be used as curve labels (legend) on the resulting plot.

3. Choose data to compare. Only plots present in all runs will show up. (f.ex. if there
were no “Pressures” plot in run#6 on Figure 39 checkbox wouldn’t show up)

5000.0.1.0
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Figure 40. Comparison Plot

Working with Plots

Viewing plots and curves

Viewing a selected subset of plots and curves is possible by only highlighting the chosen
folders. Use the Shift and/or Ctrl buttons in combination with mouse clicks to make the
selection.

Moving, Copying, Renaming and Deleting Plots

In Plots Viewer, right click on the icon of the subject plot il and options for Cut, Copy,
Paste, Delete, Rename, Move Up, Move Down and New Folder are displayed.

Accordingly the right click on the individual curves icon = gives the same options as for
plots except for New Folder.

Alternatively the above operations may be performed through predefined icons or Edit
command.

The following action, among other things, may be performed:
One curve may be copied from one plot and pasted in another; Copy-> Paste
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A new plot may be made by selecting; New Folder — this way you make your own
customized plots

The various curves may be given a new name; Rename

Saving Plots
Plots may be saved from Plots Viewer using File>Save As or Save Selection As.

The Save As option saves all plots in the Plot Viewer, while the Save Selection As
option saves only the selected plots.

Loading Plots

The saved plots may be loaded in the Plots Viewer through File=>Open. Please note that
the plots may only be loaded from a Plots Viewer.

Exporting Plots as an Image File

A plot may be exported as an image file; Plots Viewer->File>Export Plot as Image
file.

Copy Plots to Another Application

Plot may be copied to text editors or presentation-ware, e.g. Word or PowerPoint. The
procedure is to click inside the plot window, choose Edit=>Copy and then Paste it into
the destination application.
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External Data — Import and Plotting

External data such as PLT data may be imported and plotted separately or in combination
with simulated results from NETool. See External Plots sheet in the NETool window. An
example is illustrated in Figure 41.

R i Yiew UsHs ol

=M [ ——— 3lbal Betings Fhikd Fraparies R
Cende | Page P || Data : Wit PLT
F h 1 e | FLT Lipuds Dawntals e rate FaTilicng] FILT Linpeis Domshale :E‘-‘:.k.;::;::qd
- @] Wharpreiad PLT 0000y
i o PLTLigups Dpsrhple | [ ¥ s kit ND aoon!
= ialay
Hassuihge s | [=| Ao
K awls i by viskile; T I
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¥ s g | G000y \
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W o lphet Rezenmirraas A '\\\-
20 i by isil_flawrair |STEray | || 2 o
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Vo lrithmic; oty O
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Figure 41. External Plots Sheet

The following buttons are available on the very left side:

Page — adds a new plot page to the input and results. Several plot pages may be added.
The Plot page title may be edited and the Transposed box may be checked/unchecked.

Plot — adds an additional plot to the page in both input and results. Several plots are
allowed per page. The Plot title may be edited and the Transposed box may be
checked/unchecked. Further, the labels type and units of the axes may be selected. The
value of zero on the axes may be forced be visible. The axis scale may be linear or
logarithmic.

Data — adds a new curve to the active plot on the page. Several curves per plot are
allowed.

Plot data can be cut and pasted to and from Excel and other software with similar data
format.

Drawing type — selects how the data is plotted line — the data is taken as data points and
connected with strait lines segment — the data is taken as an average for that segment of
the data and is constant for the segment. Enter data top and data. points — the data is
plotted as points

Drawing fill — changes the plots appearance none — data is plotted as lines. zero — fills the
plot are from the line to the zero with color. This option is useful for data containing
both positive and negative values. bottom — fills the plot area below the line to the bottom
of the x-axis with color.

Number of Curves — use this to increase/decrease the number of curves plotted.

Note: decreasing the number of curves will cause loss of y-value data for those curves no
longer present.
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Legends — Enter the label for that set of y-values as it should appear on the plot. This
entry appears only when number of curves is greater than 1.

Data Points — enter the data to be plotted new rows will appear automatically as needed
copy/paste works from several formats including formatted text and Excel format.

Rename — Page, Plot and Data names may be edited (by right-clicking rename, rename-
icon at top left or editing titles/legend in middle part of External Plots sheet)

Trash can button — deletes active page, plot or data
Up and down arrows order the page, plot and data

A simulation has to be run in order to generate external plots within the Plots Viewer
together with the simulated data. The manipulation of the external is similar to that of the
simulated results.
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Configuration

Memory Size

The memory size of NETool can be increased by adding a key to the NETool’s launching
shortcut.

NETool is launched by run netool.exe. Modifying the command line argument -Xmx
will increase the size of maximum Java memory allowed. The default maximum memory
size is 512 MB. If one needs to increase it to 1024 MB the command line in the Netool
shortcut should look like:

“C:\Program Files\Landmark\NEToolxxx\bin\win64\run_netool.exe” —Xmx1024m

METool Well Simulator Properties

General | Shartcut |Dpti0ns Faont | Layout | Calors | Security

m MET ool Well Simulator

Target type: Application

Target location: wingd

Target: | ETool B, 24bintwinE44un_netool. exe' -mxS12m |

Start in: | |

Shortcut kew: |None |

Bur: | Mormal window hd |
Comment; | |
[ Firnd Target... ] [ Chanhge lcon.... ] ’ Advanced... ]

I 0K ] ’ Cancel ] [ Apply ]

Figure 42. Configuring Java Memory Size

Configuration File

The NETool configuration file ntld.conf is located under <<NETool_Installation
Folder>>\etc\ntld.conf. It can be edited by using a text editor.

The default location of the NETool repository/database can for example be altered by the
parameter personal data_folder:

Add this content on a separate line in the file:
personal_data folder = <<Your preferred path to the repository>>
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o If the value starts with a drive letter (or a slash), the value will represent an
absolute path, and hence the value defines exactly where NETool repository will
be located. For example: personal data folder = C:\some place\netool files On a
multi-user systems that will cause all users using the same repository.

e If it's a relative path, i.e. it doesn't start with a drive letter and/or slash, then the
path will be defined to be relative to My Documents folder of the user running
NETool. For example: personal_data_folder =My NETool Files refers to “My
Documents\My NETool Files\”.

e SUSER (case sensitive!) can be used as parameter and will be replaced with the
system user name. For example, if the Windows user name is "John Smith":
personal data folder = C:\some place\$USER\NETool\$USER means “C:\some
place\John Smith\NETool\John Smith\”

UNC network paths such as \\server1\abc can also be used on Windows

Personal Data Folder location can also be changed through Edit->Preferences->Folder
for User Files.
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Units

Data can be supplied and reported in a variety of units. NETool automatically converts
between different units.

Four main unit sets are available: SI, Metric, Metric + Diameter in inches and Field.
However, NETool has more units available than the Metric and Field unit collections
offer together.

Use File=> Units to select Metric or Field as preferred unit set. This controls the preferred
units when displaying data values and default units for entering data values.

If you create a new well case the default units system is “Metric + Diameter in inches”.

The selected unit set for a well case is stored with the well case and used when the case is
reopened in NETool.

Please note:
NETool’s Metric and Field unit collections differ slightly from the Eclipse definitions.

PVT tables using Eclipse format must be defined in Eclipse’s own Metric or Field unit
definitions.
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Convergence Problems and Simulation Time

Simulation time

Simulation time is generally a function of numerical resolution and accuracy
requirements.

Numerical resolution is controlled by number of nodes and number of intermediate nodes

In addition can grid upscaling use considerable time if the number of nodes or number of
grid blocks is high. The accuracy of upscaling can be modified in order to reduce the time
used on upscaling.

Convergence Problems

NETool is a numerical simulator and may experience convergence problems. It cannot be
guaranteed that any case can be solved by NETool.

Typical causes of convergence problems are (in order of occurrence):

Too wide pressure limits (Global settings->Advanced->well pressure limits)
Inconsistent or unphysical input data, especially PVT data

Areas with small pressure drops which causes directional oscillations

High saturation, reservoir pressure and/or permeability contrasts along the well
High oil viscosity

Recommended remedial actions are to consider 1) input data, i1) numerical parameters in
Global Settings—> Advanced and iii) adjust nodes/intermediate nodes:

Verify PVT data and other input

Adjust Well Pressure Range

Increase or reduce Number of Intermediate Nodes (consider node spacing)
Increase or reduce Number of Nodes

Enable “Smooth Pres over” or “Iteration step damping” in Global settings-
>Advanced

Adjust Momentum Balance control

Use correct Hydrostatic options

Increase “Precision of calculation”

Reduce “Stability”

Adjust PVT Derivatives settings

5000.0.1.0 Page 108 of 113 2012



Landmark NEToo0l™ User Guide

Recent Developments

Developments from 5000.0.1.0 to NETool 5000.0.0.1:

Multi-annulus feature is implemented. Netool can simulate four annuli instead
of one. “Segment Settings/Completion->Hole&Completion->Segment type” is
now replaced with five columns: “Casing/liner”, “Screen”, “Inflow control”,
“Stinger”, “Tubing”. Each of these layers has an individual completion.
Netool UI uses new “Nimbus” look & feel and Java version 7.

Rs and Rv are now independent unknowns at every node instead of one
average value for the whole well. Old model can be enabled by checkbox in
“Global settings->Advanced->Simplified Rs/Rv handling = true”

Added the following functionality to the Completion Plot: resizable segments,
autozoom on selected segments, zoom slider (results window only), add/delete
segments.

ICD’s are grouped under “ICD” completion type.

Option added for ICDs and valves to use Discharge Coefficient vs. Reynolds
Number table.

Option added to define reference reservoir pressure for hydrostatic correction at a
certain MD rather than heel.

Reservoir pressures can now be “upscaled” (like permeabilities) and low pass
filtered (Global settings->Advanced->smooth Pres over).

Re-arranged panels in the main UL

New models for Halliburton Autonomous ICD.

Added “momentum” (Global settings->advanced) option.

Added “Cables in annulus”.

Moved “Junction Type” into “Segment Settings->Hole&Completion”
Restored and improved OLGAS coupling.

Added API to netool.dll to run Netool UI/Plots from reservoir simulator.
Greatly improved Netool-Quiklook coupling.

Multiple bug fixes.

Developments from 3.2.2 to 5000.0.0.1

Coupling:

Dynamic coupling with “Quiklook™ reservoir simulator has been implemented.
Netool SDK designed for coupling Netool with third party software is a product
available under “NETool DLL” brand. It comes with Netool setup and can be
selected during installation process.

Simulation features:

New vertical pressure drop correlations at Global settings->General->Pressure
drop method: “Aziz, Govier, Fogarasi” and “Duns & Ros”.
New completions: Generic Screen, Perforated Pipe Screen.
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New ICD completions: Statoil Autonomous ICD and Halliburton Adjustable ICD
Packers can now be sealing or non-sealing.

Netool reads RelPerms from Eclipse-format restart files if available.

Supported Grid coordinates in addition to Geographic coordinates with dynamic
switching between the two coordinate systems.

GUT/usability improvements:

Netool GUI adapted to Landmark 5000 series software release.

Added simplified training mode designed to be used in training classes.

New interface for comparing plots.

Added Completion Schematics the input screen and “Plots Viewer".

Added "Inspect Gridblock" button on Reservoir view screen: an easy way to get
information about any gridblock in the model (all data + geometry).

Added window for automatically adding and removing packers between every
segment.

Modified File->Open/Save dialogue window.

Added “Data” tab for every plot which shows the actual data used.

Added more options for vertical plots scaling ("Axis Scale" button under plots)
Average values for some plots at the bottom of "Data" tab in plots viewer are
printed.

Screen completion regrouped: instead of WWS user has to chose "Screen". Under
it the following types are available: WWS and new completions Generic Screen,
Perforated Pipe Screen.

Bernoulli pseudo-segments are hidden in the output.

"Nodes" terminology replaced with "segments" in Reservoir input Ul

Rearranged Cased Hole Gravel Pack inputs.

Moved "PLT overlay" to Global Settings->General.

Single "External plots" in a well case, not per lateral as before.

Added %-of-total scale on the right hand side of stock-tank flow rates plots.
Added SI Units mode.

New licensing GUI

Enter License does NOT use FLEXIm's Imhostid or Ic hostid() any longer.
Instead it gets the list of network interfaces, removes all that look like non-
hardware ones and print MACs together with interface descriptions.

Created C#/dotnet bindings for netool.dll

Bug fixes (also improved in 3.2.2):

Plots->Save All As: Fixed wrong encoding in the XML header.

Enter log sometimes fail.

Fixed problems with some Eclipse-format files originating from CHEARS.

If the segment type in Reservoir tab is changed, the tree-view in Segment Settings
might not update

Changed default values for minor loss coefficient for Tubular and Channel ICDs
(0->1.6) and “Max Well Pressure” in “Well Pressure Range”
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Developments from 3.0.6 to 3.2.2

Modeling:

Fixed wrong usage of hidden pressure limits

On Windows increased stack size limit to prevent crashes in rare cases
Significantly improved algorithm for grid-block intersections.
Improved cases with exceptionally high number of gridblocks

GUI fixes and improvements:

Fixed copy-paste to MS Office-2007

fixed some plots failing to "compare". (For example "Oil PVT")

fixed dialogs sometimes showing with wrong (almost zero) size.

"Enter Log" now uses table instead of text area.

fixed reservoir_view->top_panel->"Depth" for reservoirs with LGRs

Fixed velocity plots offset by 1 segment.

fixed empty error message if plots viewer started with no license

proper error message in some cases when output is too big

improved layout of "External Plots->[data]"

disabled File->Export Netool binary grid for gridless cases

Improved cases with exceptionally big tables (e.g. "Details" table) by parsing it
only if clicked on.

Increased Java max stack to 512MB to avoid OutOfMemory errors

Added online help for Tubular and Channel ICDs, updated Nozzle ICDs help

Installation/startup defects:

Fixed InstallShield installing wrong flavour of Java on Windows64.
Print more info for support and do more checks at startup

General:

Enabled Sentinel dongles code to get old dongles working.
The GUI for entering Sentinel dongles is now removed.
Linux version: fixed compatibility with RHEL-5.

Developments from 3.0 to 3.0.6

Re-branding: NETool has been acquired by Halliburton from AGR Petroleum. All
trademarks, contact information, support, etc has been adapted to be used by
Landmark Graphics Corporation (LGC) - Halliburton software division.
Licensing: A single-user hardware locked version of FlexLM license is now
supported. NETool proprietary license type is now discontinued.

Added input option for PLT data: PLT data could now be entered in the output
folder under Global Settings.

New Injector PI model: A new model that simulates the start up of the injection
process is added.

5000.0.1.0 Page 111 of 113 2012



Landmark NEToo0l™ User Guide

e Added support for Eclipse PVCO, PVCDO keywords in PVT table

e Added support for 64-bit platforms: NETool runs on the 64 bit versions of the
following operating systems: Windows XP Vista; Linux.

e Added completion types: Three general ICD types are now available as
completion parts:

o Nozzle ICD (formerly named Generic ICD)
o Tubular ICD
o Channel ICD

e Added plots in result viewer

e Fluid velocity within an ICD unit can be plotted and Reynolds number within an
ICD unit is now available in the table details.

e Added a new feature to define intermediate nodes: A new option to define
intermediate nodes has been added as an alternative way to the original for
intermediate node definition. The new option defines the location of intermediate
nodes based on a user-defined-spacing. The spacing can be defined independently
for each segment. The new method calculates the number of intermediate nodes
required for a segment based on the defined spacing, and then distributes those
nodes evenly within the segment. The new option makes it easier to control the
resolution of the model when the individual segment sizes vary.

e Enhanced numerical performance: General convergence improvements, for
example for multi-lateral wells, wells with variable fluid phase fractions along the
well path and for cases with lift curves. Improved calculations speed of the
numerical solver.

e Non-Darcy flow behavior: Improvements and new features to general non-Darcy
skin and Forchheimer skin specifically have been introduced. An option to model
non-Darcy pressure drop in gravel packs and collapsed annulus has been added.

e Enhanced momentum balance modeling: Improved flow modeling by including
compressibility effects.

e Improved flow modeling by adding the Bernoulli effect resulting from velocity
changes caused by flow area variations.

e Added a new feature allowing lift curves for injectors: Injector lift curves can be
used to control injection by a tubing head pressure or to calculate tubing head
pressure when injection is controlled by other simulation targets. Injector lift
curve is defined by the Eclipse format VFPINJ keyword.

e New features for more advanced inflow modeling: Added an option for non-linear
productivity models. For oil and condensate producers the option models the
effect of condensate banking and gas-break out in near-wellbore area. For dry gas
producers the option models the inflow similar to the pressure-squared method.

e Enhanced modeling of flow between completions sections adjacent to Open Hole
Completions: Tubing nodes in Open Hole completions can now be connected
with both annulus and tubing nodes in completions types that have flow within
both the annulus and the tubing. Previously the Open Hole completion was only
connected to the tubing nodes in the adjacent segment.

e Enhanced modeling of multiphase hydrostatic calculations: The option to include
hydrostatics in the well hydraulics calculations has been enhanced. The
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hydrostatic calculations are now based on local fluid densities rather than an
average fluid density for the entire well. The new modeling handles multiphase
fluids and acts separately for annulus and tubing.

e New feature for relative permeability modeling: An additional option has been
added where relative permeabilities are defined based on Wyllie’s correlations.
Both Wyllie’s correlations for i) cemented sandstone, or oolitic limestone and ii)
well sorted unconsolidated sandstone is supported.

e Enhanced modeling of cross-flow: Two-phase modeling of crossflow is
supported.

e Enhanced definition of skin: Input of different skin has been reorganized. Output
of skin calculations has been improved.

e New PVT feature for definition of formation volume factor (Bg) for wet gas: The
gas formation volume factor, B,, at a particular Gas Condensate Ratio (R,) as
input into NETool (or taken from the reservoir grid) can now be calculated by
linear interpolation between the saturated and dry gas values.

e Added a new feature that allows for Power Law fluids: Single phase Power Law
fluids can now be modeled.

e Extended Phase modes: More phase modes are support, e.g. two-phase Oil &
Water and Gas & Water...

e Extended PVT modeling: Simultaneous modeling with vaporized oil (Ry) and
solution gas (Rs) is now supported.

e Enhancements to Model Builder (pre-processor): Bird-eye view of the reservoir
grid has been altered. It has been rotated 90° such that North is up and East is
right.

e Enhancements to Results Viewer (post-processor): Added more information to the
table Details. Added new plots: Velocities in annulus and tubing Inflow volume
fractions and tubing volume fractions

e Graphical Presentation of External Data: External data can now be added and
presented together with results from NETool simulations. This capability
facilitates a bit easier history matching of PLT results.

e Grid Coarsening allowed: Eclipse grids with Grid Coarsening are now accepted as
input.

e Phase slip for collapsed annulus and gravel pack: Phase slip for Darcy flow is
introduced for collapsed annulus and gravel packs.

e Support for Microsoft Vista: NETool can now be run on the operating system 32-
bit Microsoft® Vista.
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